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Introduction and about this guide 
This guide is aimed at users new to the MooD Intelligent Architecture Platform (MooD 16). It 
assumes a familiarity with the basic purpose of Enterprise Architecture, Performance 
Governance and Business Modelling. 

MooD is feature rich and this guide introduces many of these features. It is not meant to be 
read cover to cover. Nevertheless, it is structured as follows: 

• Introducing MooD technology (page 10) 

This outlines what MooD is, and what it can be used for. 

• Repository Manager (page 11) 

Architectures are held in repositories (databases). This short section introduces 
Repository Manager. There is a separate Repository Manager guide. 

• Business Architect (page 13) 

This is where you create and manipulate business models. As Business Architect is the 
application you will use most, the bulk of this guide is dedicated to it. This section is 
subdivided into sections on key concepts, the user interface, building element 
hierarchies, and finally a section covering many of Business Architect's key features. 

This is a Getting Started Guide. It is principally aimed at explaining the MooD workflow and 
introducing key features. 

About boxes like this 

Boxes like this include supplementary information. Reading them is not critical to getting 
started. But, if you want to know more, they give you a fuller picture. 

Suggested reading order for users new to MooD 
Everything in MooD revolves around elements and the relationships between them. Because of 
this, if you are new to MooD and Business Architect, we suggest you look at the Elements in 
Business Architect section first, and then look at the Key features section as you add and 
encounter things in your repository (queries are particularly important to understand). As you do 
this, refer to the Key concepts section for background, and the User interface section for help in 
fully utilizing the working environment. This guide is not meant to be read cover to cover as 
some of the concepts and user interface features will only become apparent when you use 
particular features. 

 

Only a subset of the documentation is included with the installation. More documentation is 
available on our support site including: 

• Guides such as: Aggregation Designer, Aggregation Fact Builder, Aggregation 
performance, Excel Import synchronizer, Denormalised Excel synchronizer, Model 
Driven Documents (MDD), Free Form Matrix, Epochs, Measures, General chart, Radial 
chart, Clock Face chart, Project and Risk Performance charts, World Map panel, Data 
Tables theme, Deployment Packs, User management and Permissions, Active 
Publisher Setup, and using SSIS with MooD. 

• Several shorter pieces of documentation are also available as "Quick Guides" and new 
documentation is added throughout the year and particularly alongside a wide product 
build release. 
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• Short videos are available covering Aggregations, Aggregation caching, MDD, 
Measures, pinning variables, Queries and Query Builder, Relationships, Excel Import 
SAT functionality and Session Variables. New videos are added as they are produced. 

Go to the Support area at www.moodinternational.com to see the full list of documentation 
available.  

Technical support 
MooD 16 is backed by a dedicated UK based technical support team. Contact details can be 
found on Repository Manager's File tab. 

Note: You may be supported by an intermediary and not directly by MooD International. 
Your system administrator should be able to provide you with details. 

  

http://www.moodinternational.com/
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Introducing MooD technology 
MooD International's Intelligent Architecture Platform is an award-winning software platform for: 

• Enterprise Architecture, business models and 'traditional' architectures. 

• Developing performance governance solutions. Solutions leverage business models. 

The MooD Intelligent Architecture Platform comprises two main components: 

• MooD Business Architect: 

A Windows client-side application used to develop and manage the business model, 
and to configure MooD solutions based on it. 

• MooD Active Enterprise: 

A set of Windows server products that exploit standard enterprise web technologies to 
deploy solutions across a wide community of users. 

Put simply, Business Architect lets you build models and solutions. Active Enterprise lets you 
deploy solutions on the web. 

These key MooD components are supported by other components and technologies, including: 

• Repository Manager: 

A business model is held in a repository (database). This application lets you manage 
your repositories, and open them in Business Architect. 

• Synchronization Activation Technology (SAT): 

This MooD technology lets you synchronize your business model with external 
applications and data sources. You can have any number of synchronizations, and you 
manage them in Business Architect.  

• Data Table Themes 

A high performance method of connecting directly to external data.  

 

This is a very brief overview. MooD International's website (www.moodinternational.com) 
includes much more information on MooD technology. 

  

http://www.moodinternational.com/
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Repository Manager 
This section is a basic introduction to repositories and Repository Manager. There is a 
Repository Manager Guide that covers these aspects in detail. 

About repositories, servers and Repository Manager 

 

A repository is the entity that holds your architecture. It is a database instance that collects 
together everything that makes up your architecture. 

Repositories exist on servers. In MooD, servers are database servers, not just physical 
servers. A physical server can contain many database servers, in which there could be many 
MooD Repositories.  Tags are useful to help manage many repositories. 

When you start MooD from the desktop icon, Repository Manager starts first. Use Repository 
Manager to define which servers and repositories should be available to you, from there you 
can use it to: 

• Open a repository in Business Architect. 

• See repository details such as size and last modified time. 

• Create, rename, remove (hide) or delete repositories. 

• Upgrade repositories when you get a version of MooD with a new schema (if you install 
a new version and all your repositories appear brown (sepia), it is due to a change in 
schema). See About schemas next for more details. 

• Create backups (SQL Server only). (To restore a backup, you can drag the .bak file into 
a group on the Repositories tab. 
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• Merge repositories together. 

• Validate and repair the data within a repository. Validation is a recommended step prior 
to making a repository available using Active Enterprise. Validation can also help 
resolve structural issues within a database. 

• Improve database performance by defragmenting storage. 

• Manage your MooD licence. 

About schemas 
All builds of MooD and consequentially all MooD repositories have an underlying schema. This 
is the database structure it is built upon. The MooD schema changes less frequently that the 
MooD build. Builds introduce features and fixes on top of a schema. Hence, a schema can 
support several builds. The schema only changes when a new feature requires a change to the 
underlying database. 

Repositories that do not match the schema of your current build appear in shades of brown 
(sepia) and cannot be opened in your version of MooD unless upgraded to the same schema. 
To upgrade, first ensure you have a backup of the repository, then highlight the repository and 
then select Upgrade (it is one of the few commands available to you). However, note the 
following: 

Once a repository has been upgraded to a new schema, you cannot open it in a 
version of MooD with an earlier schema. 

Note: If you have a repository that appears brown and you are not given the Upgrade 
option, the repository is on a newer schema than your current installation. You will 
not be able to open this repository unless you get a newer version of MooD itself. 

Mandating a Build 

Business Architect includes a complementary feature called mandate. This lets you specify a 
specific MooD build (version of Business Architect) that the repository must be edited with. If 
you try and open a repository on a different build (but same schema), Business Architect warns 
you but will let you proceed. Mandating a build helps development teams ensure they always 
work on a set build of Business Architect. Mandating is optional and can be found (in Business 
Architect) under File > Manage Repository > Mandate a Build of Business Architect. 
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Business Architect 
Business Architect is where you construct and leverage your Enterprise Architecture to provide 
solutions. Business Architect is covered in the following sections: 

• Key concepts (page 14) 

Some key concepts that you need to know when using MooD. 

• Business Architect's user interface (page 22) 

Helps you understand, and get the most from, Business Architect's workspace. 

• Elements in Business Architect (page 56) 

How to develop element hierarchies. 

• Key features in Business Architect (page 73) 

This section introduces some of the features available to you. For example, it includes 
sections on queries, action panels, aggregations, synchronization and Manage 
Themes. 

About permissions 

This guide assumes you have been granted Administrator user privileges on a repository. If 
you find that some features are denied you, ask your system administrator about the 
permissions you have. In addition, some themes can be configured to restrict certain 
functionality. Your system administrator (or a more experienced user) should be able to 
advise you. 
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Key concepts 
When using Business Architect, you will become familiar with the following terms and concepts 
introduced here: 

• Theme 

• Element (page 14) 

• Subject element 

• Relationship (page 16) 

• Measure (includes epoch) (page 17) 

• Model (page 18) 

• Panel (page 18) 

• Query (page 18) 

• Matrix (page 19) 

• Aggregation (page 20) 

• Synchronization (page 20) 

Some sections include info boxes that provide more detail should you wish to develop your 
knowledge of a concept further. 

Theme 
Themes are blueprints. They are a classification and structural definition of elements and the 
relationships that can exist between them. Themes define the meta-model for your enterprise 
architecture or business model. 

Any themes that you (or the person responsible for your meta-model) add are known as 
universal themes. Universal themes support one or more element types. Element types 
define the fields that an element can have. 

Themes correspond to element hierarchies in the Explorer Tree. If a theme has more than one 
element type, when you create elements, you choose which element type to base the new 
element on. For example, if you have a Projects theme that includes Internal Project and 
External Project element types, when you create an element you choose between these types. 

More on themes – What you might have 

If you use Repository Manager to add a new repository, it will have some default themes, 
including the Processes, Objects, and Users themes. These themes are not universal 
themes so you cannot add more element types to them. 

To see what themes you have and explore their structure, on the ribbon, click File, point to 
Manage Repository, and then click Manage Themes. This opens the Manage Themes 
dialog box. You should be careful about changing things. However, you can use Manage 
Themes to hide themes so that they do not appear in Explorer Tree. See Introducing 
Manage Themes (page 151) for more information. 

Element 
An element is any instance of an element type within a theme. Elements are the building 
blocks of your business model. Elements exist in a hierarchy, and each element is uniquely 
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identifiable within a repository. This is easily seen in Business Architect's Explorer Tree, as 
shown in the following image: 

 

Elements are the focal point of Business Architect. You can easily see your elements, open and 
view or modify their definitions, relationships and dependencies, and manage all the things 
associated with them such as models, matrices and queries. Most things in Business Architect 
revolve around the concept of the element. 

More on elements – Relationships, dependencies and variants 

Elements exist within a hierarchy. This hierarchy is constructed using parent child 
relationships within a theme. 

An element's: 

• parent element is its immediate ancestor element. 

• child elements are its immediate descendant elements. 

• sibling elements are any elements located at the same level in the hierarchy. 

• ancestor elements are any elements higher in the element hierarchy (the theme is at 
the top of any hierarchy). 

• descendant elements are any elements lower down the element hierarchy. 

Relationships can also be non-hierarchical. You have standard relationships between 
things like Project elements and Team elements, and measure relationships between 
things like Project elements and Cost measures. 

Relationships are one type of dependency. An element can have other dependencies, 
including measures and aggregations involving the element, and models where the element 
is used. For any element, in Business Architect, you can view a pane (the Examine pane) 
showing you all its dependencies organized by category. This lets you quickly understand an 
element's place within a repository. 

Elements can also have, or be, variants. Variants are copies of elements and their 
relationships. Variants know what elements they are derived from, and elements know of 
their variants. See Variants on page 139 for more details. 



MooD 16 Getting Started Guide 
 

 16 

Subject element 

A key concept in Business Architect is the subject element. This is the element that is the 
primary focus of models, Info panels, charts, queries and other items. It is the starting point for 
many dialog boxes and features. 

Business Architect often assumes the subject element for you, but you can usually change it or 
make it a parameter so that you can pin it to something else. 

Relationship 
Relationships define how element types can relate to other element types or to measures. As 
such you have standard relationships and measure relationships. Relationships are non-
hierarchical (i.e. not parent child). Relationships are defined within Manage Themes. Element 
types can include relationship fields which dictate which relationship can be held in that field 
(what element types or measure types you can drag into it). 

An example helps illustrate standard relationships. You have Project elements and Team 
elements. These elements are not related by hierarchy but they do have a relationship in that 
projects are undertaken by teams. Hence you need a relationship between the two. For this you 
create a standard relationship called Team Assigned, and in the Project element type you add 
a relationship field that uses Team Assigned. This means that in Business Architect, when you 
open a Project element, it has a Team Assigned field that you can drag Team elements into. 
Having Team Assigned defined on its own as a standard relationship makes it available for 
reuse. For example, you could use the same relationship to link Location elements to Team 
elements. 

Relationships are used throughout MooD. For example, in queries you will frequently want to 
find the elements at the end of a relationship. Extending the example, this would be 'find the 
Team elements associated with a Project by using the Team Assigned relationship'. 

Finally, there is the concept of reverse relationships. Again, this is best explained by 
developing the example. Because Project elements include the Team Assigned relationship 
field that links them to Team elements they are linked by a forward relationship. Team 
elements don't have a relationship field, but they do have an implicit reverse relationship to 
Project elements because they are at the end of the Team Assigned relationship. MooD makes 
these reverse relationships available to you (look for Used By in the relationship name (see 
note)). Hence starting from a Team element, you could find its associated Project elements by 
using the Used by Team Assigned reverse relationship. You do not have to create the reverse 
relationship yourself. 

Note: "Used By <forward relationship name>" is the default name MooD gives to reverse 
relationships. However, this can be changed within Manage Themes. If you do 
not see "Used By" names in your repository, ask the repository owner about the 
names used for reverse relationships (or look in Manage Themes). 

This next diagram summarises standard relationships, and how they are created in Manage 
Themes. 
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There is also a video covering how to create relationships in Manage Themes. This is available 
within the Support Area at www.moodinternational.com. 

Relationships themselves can have fields. For example, a Project to Team standard 
relationship could have a Capacity field to hold a figure specific to each instance of the 
relationship. Note that if you want to SAT into the fields on a relationship, use the Microsoft 
Excel synchronizer's Denormalised layout. 

Measure 
A measure is an element that quantifies or measures some aspect of another element. For 
example, Cost is a typical measure applied to Project elements. In other terminology, measures 
are Key Performance Indicators (KPIs). 

Measures are created by defining a measure type within Manage Themes. Measure types are 
similar to element types in that they define structure and behaviour. Also in Manage Themes, 
you can create a measure relationship that when given to an element type via a measure 
relationship field, specifies that that element can be measured by that measure. 

Note: A guide covering how to create measure types in Manage Themes is available 
within the Support Area at www.moodinternational.com. There is also a video. 
However, the Creating Measure Types in Manage Themes section (page 154) 
includes a quick reference taken from the full guide. 

When an element has a measure applied to it, each result is known as a measure instance. 
Measures can include thresholds. Thresholds determine the status of measure instances. This 
status can be visually represented. For example, thresholds are often used to apply traffic light 
indicators to elements. 

http://www.moodinternational.com/
http://www.moodinternational.com/


MooD 16 Getting Started Guide 
 

 18 

Measures can be epoch aware. Epochs are chunks of time, for example, calendar months or 
years. When an epoch aware measure is applied to an element, measure instances are 
created for selected epochs. This lets you measure and analyse performance over time. 

See Measures on page 136 for an introduction to using measures in Business Architect's 
Explorer Tree. 

Model 
A model is a diagram that elaborates some aspect of an element. Models help you navigate 
and visualize your business model. For example, a top level process is likely to have a model 
that shows how its sub processes link together. Each sub process is likely to have a model 
elaborating its steps. 

Models are views of an element. To construct this view, you place related or dependant 
elements together on the model, and add other information, such as links, to define structural 
and functional relationships. You can also add other components such as Info panels, graph 
panels and matrices to display the detail you require. 

Models also let you build web based MooD solutions (Active Enterprise). By adding action 
panels to models, you construct the 'screens' of your solution. 

Panel 
Panel is the general term used for items that help you represent and convey your architecture 
on models. Panels are grouped into: 

• Info panels 

Info panels show information about elements or links. See Info panels on page 82 for an 
introduction to creating and using Info panels in Business Architect. 

• Graph panels 

Graph panels include numerous charts, gauges, and map controls that you can use to 
display information about elements. See Graph panels (gauges, charts and maps) on 
page 110 for an introduction to including these on models. 

• Action panels 

Action panels are assorted controls that can make your models interactive and web 
deployable. See Action panels (making models for the web) on page 113 for an 
introduction to including these. 

More on panels – Active Enterprise 

Many panels are designed specifically for web deployment, and many panels gain additional 
features when displayed in a browser. For example, Radial charts can be animated on the 
web. 

Business Architect includes a test environment (Web Preview) that lets you see how a model 
will look when deployed in Active Enterprise. 

Query 
Queries are used extensively to find elements that match a set of criteria. For example, you 
could create a query that returns all project elements with the status Critical, which could then 
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be used as the rows in an Info panel. You can use the list of elements returned by a query in 
many ways, including: 

• As an input to a matrix. 

• To provide content for charts. 

• As the input to another query – you can have nested queries. 

Queries are reusable and most things in MooD are driven by queries. It is a key area to 
understand and Business Architect includes a dedicated Query Builder interface to help you. 
See Queries on page 74 for an introduction to creating and using queries in Business Architect. 
There is also a video introducing queries and Query Builder. This is available within the Support 
Area at www.moodinternational.com. 

Matrix 
A matrix is a table used to display information. Matrices have a subject element. This is the 
element that the matrix takes as its starting point. To help you construct matrices, Business 
Architect includes Matrix Designer. 

Once you have a matrix you can: 

• Include it as it is on any model. 

• Add it as a thumbnail to any model – this thumbnail shows the matrix as it was when it 
was last executed. You can click the thumbnail to open the actual matrix. 

• Add it to the model of another element, and draw its content from that element (the 
matrix must be configured to use the matrix subject as its starting point). This means 
that you can define a matrix for a particular purpose, and then reuse it against many 
elements. 

• Include it in a Model Driven Document (the Documents synchronizer). 

• If it is an Aggregation matrix, use it to drive a chart or graph. This gives you many ways 
to visualize the content of an aggregation.  

• You can use Matrices to power another panel.  

See Matrices on page 102 for an introduction to creating and using matrices in Business 
Architect. 

More on matrices - Matrix types 

There are several matrix types: 

• Data Sheet. Displays fields and other information about elements. For example, 
elements as rows, and the columns showing field values. You can also include Smart 
Columns as columns. 

• Pick List Ticks. Displays elements as rows, and Pick List items as columns. You can 
display icons instead of ticks. 

• Relationship Field Ticks. Displays elements in the X and Y axes. Tick marks at 
intersections show whether a pair of elements are related by a particular relationship. 
You select a standard relationship and then define queries to populate the axes (if 
suitable, the second query (axis) can be auto generated via a setting on the Matrix 
tab). The Matrix Designer also includes a Change button to flip the axes (and in 
effect support the reverse relationship). 

http://www.moodinternational.com/
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• Time Line. Displays time related information for elements. You can include bars 
between dates, milestones, dependency lines and date markers. You can also add a 
Datasheet type column to a Timeline Matrix. 

• Bar Chart. Displays numeric information for elements. Elements appear as rows, and 
the columns show a progression of values. 

• Free Form. Displays elements on both the X and Y axes, and shows, by means of a 
query, how they are related. This type of matrix is flexible and suitable for occasions 
where one of the other types doesn't fit your requirements. You can include Smart 
Columns in this type. A guide is available within the Support Area at 
www.moodinternational.com. 

• Aggregation. Totals values across multi-dimensional views and groupings allowing 
you to summarize, analyze and compare data. Aggregation matrices and Smart 
Columns form MooD's aggregation technology. Several guides covering aggregation 
are available. 

Aggregation 
Aggregation is the generic term for two features: 

• Matrices of type Aggregation. 

• Smart Columns. 

Both share the same technology. Aggregations are calculations on repository data that produce 
results. These results can be displayed in tables or Info panels, used to drive charts, or used as 
the basis for conditional formatting. 

All aggregations use facts. Facts are calculations that produce results. For example, you might 
have a fact that divides Project Cost by Project Days to produce a Cost per Day result. The key 
point being that the result itself is not held in a field. It is calculated when required. Aggregation 
matrices can have multiple facts (columns in the table) and Smart Columns can have a single 
fact. 

As a broad distinction, Aggregation matrices are designed to be seen on models or used to 
drive other panels (charts and graphs). Smart Columns are designed to produce results that 
can be utilised elsewhere, for example, to determine what conditional formatting to apply, what 
label to use (facts can output strings as well as numbers), or as a column in a Data Sheet 
matrix. 

Note: In documentation, when you see "Aggregation matrix", it is specifically referring to 
matrices of that type. "Aggregation" on its own includes Smart Columns and 
Aggregation matrices. 

A video introducing aggregation is available within the Support Area at 
www.moodinternational.com. Aggregation matrices are not covered in this guide, but see Smart 
Columns on page 87 for an introduction to creating Smart Columns. 

Synchronizations 
Enterprise architectures absorb and produce information. MooD Synchronization Activator 
Technology (SAT) is a tool for synchronizing with external data sources. 

You can connect to an external application, or another MooD repository, and import or export 
data. For example, a common synchronization is to import from a Microsoft Excel spreadsheet, 
creating elements for each row in the spreadsheet, and populating each element with data from 

http://www.moodinternational.com/
http://www.moodinternational.com/
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the spreadsheet's columns. You can configure multiple synchronizations, and they can be 
scheduled, or executed on demand. 

See SAT on page 143 for an introduction to creating and using synchronizations in Business 
Architect. There are also some videos covering SAT available within the Support Area at 
www.moodinternational.com. This includes an introductory video covering the Microsoft Excel 
Import synchronizer. 

More on synchronizations – Types available 

MooD provides many synchronizations, including (but not limited to): 

• Microsoft Excel and PowerPoint. 

• Database and SSIS. 

• Assorted XMI and XML formats. 

• Model Driven Documents (MDD). You can generate Microsoft Word or PDF 
documents from the content of a repository. 

As with most things in MooD, a dedicated user interface makes developing and using 
synchronizations simpler. This includes a Data Mapping window that lets you hook up your 
source with your target. 

 

 

Note: In general, data duplication is a bad idea, especially if it’s sensitive or of a high 
volume. You may create a better solution by leveraging Data Table Themes, 
which can cross reference the original data, without resulting in duplication. Often 
the result can also be many times faster than using SAT.  

http://www.moodinternational.com/
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Business Architect's user interface 
The information here should help you make the most of Business Architect's user interface. 
There are topics on: 

• The ribbon (page 23) 

• The File tab (page 24) 

o Business Architect's options 

o Getting help 

• The Quick Access Toolbar (page 25) 

• The Explorer Tree (page 26) 

o Splitting the Explorer Tree 

o The Explorer Tree toolbar 

o The Explorer Tree filter 

o The Bookmarks Bar 

o The Explore button 

• The workspace (page 30) 

o Multiple workspace areas (tab groups) 

o The status bar 

o The hidden Examine pane 

o Panes and docking/floating 

o Element definition window controls 

• The Welcome page and repository shortcuts (page 33) 

• Context menus (page 35) 

• Navigation Bar (page 36) 

• How Save, Rename and Undo work (page 38) 

• How Remove and Delete work (page 39) 

• Difference between Open, Examine, Look inside, Look At and Explore (page 39) 

• Selecting, formatting and arranging items on a model (page 40) 

o Selecting overlapping or layered symbols 

o The Model tab – page setup and snap to grid  

o Pickup and Apply 

o Conditional formatting 

• Model timings and testing performance (page 46) 

• Flipping panels (page 46) 

• Pinning (green, blue and orange pins) (page 47) 

o Multiple pinning 

• Searching, filters and list styles (page 50) 
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o Search boxes 

o Element search 

o Filters 

o List styles 

• Favourites (page 53) 

• Spotlight mode and presentations (page 55) 

Note: This guide covers the default setup. This is customizable. In particular, you can 
change how the mouse functions. Business Architect options on page 25 outlines 
the customization available. 

The ribbon 
The ribbon stretches across the top of the work area in Business Architect. It gives you tabs 
and commands that are related to the current operation you are performing. 

 

The ribbon includes several components: 

• The File tab. See The File tab on page 24 for details. 

• The Quick Access Toolbar. This appears in the top left of the window and includes the 
Save button. You can customize the Quick Access Toolbar to include commands you 
use frequently, and you can position it below the ribbon. See The Quick Access Toolbar 
on page 25 for more details. 

• Command tabs, such as Home, Model, Web and View, stretch across the window, 
just below the title bar. The tabs are based on the current content of the workspace. 

• When the pointer is over the ribbon, the mouse wheel button cycles through the 
available tabs. 

• Press Alt to see the key tip badges for the ribbon. Key tips show you what keyboard 
shortcuts are available, for example: 

 

• Command groups are the sets of commands available on a tab. They relate to what 
you are trying to do. For example, the Insert, Drawing and Layout groups appear on 
the Home tab when you look at a model. 
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• Commands. These are the operations you can perform. 

• Some commands are enabled only when a relevant item is selected. For example, 
formatting commands are only enabled when something they can be applied to is 
selected. 

• An arrow on a command means that additional choices are available. This can be a 
list of settings, or a gallery of possibilities. 

 

• To see a command's ScreenTip, using the mouse, point to the command, and then 
pause. The ScreenTip will appear. If the command has a keyboard shortcut, it's 
included. 

The ribbon approach cuts down on the number of menus, commands and dialog boxes you 
have to sort through in order to find the items you want. 

The File tab 

 

The first thing on the ribbon is the File tab. It includes file and repository commands. When you 
point to commands that include an arrow, a tab of commands appears, for example: 
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Business Architect's options 

Use the Options command on the File tab to open the Options dialog box. This lets you 
customize general appearance and functionality. These settings affect Business Architect, not 
just the current repository. 

 

This Getting Started Guide doesn't cover these options in detail, but you can use the Options 
dialog box to: 

• Change the default unit of measure from inches to centimeters (the General group of 
settings). 

• Configure how the model editor functions, for example, whether moving an element's 
symbol also moves its attached panels (the Model Editor Options section in the 
General group). 

• Switch off warnings (General). 

• Change the mouse functionality (General). 

• Control what element tooltips show (General). 

• Customize the Quick Access Toolbar and keyboard shortcuts. 

• Change Business Architect's appearance. 

• Control spell checking. 

• Manage add-in MooD modules. 

Getting help 

Business Architect includes several PDF user guides, including this guide. Use the Help 
command on the File tab to see what documentation is installed. 

Note: Only a subset of the available documentation is installed with Business Architect. 

The Quick Access Toolbar 
Business Architect includes a Quick Access Toolbar. By default, this appears in the top left 
corner, and, as shown here, you can customize it: 
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The Explorer Tree 
The Explorer Tree appears on the left side of Business Architect, below the ribbon. The 
Explorer Tree shows the repository contents, including the element hierarchy. 

 

The Explorer Tree lists three groups of items: 

• User (who you logged in as) includes administrative items that let you manage and 
quickly access parts of your repository. It includes favourites and recently visited items. 

• Themes lists all your elements in their hierarchies. You can easily open and add 
elements. Users and user groups are listed here too (they are elements in their own 
rights). You can: 

• Right-click an element to get a shortcut menu for that element. 

Click the  button next to an element to open its Examine pane within the 
workspace (you get the same pane from the Examine command on the shortcut 
menu and on the ribbon (or F12)). 

• Double-click an element's icon or name to open its model (or the Create Model dialog 
box if no model exists). 

• Libraries groups reusable resources like queries, matrices, styles and Model Masters. 

Click a group's  button to open a window in the workspace listing its contents. Here 
you can quickly see what resources you've got and add new ones. 
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Note: In the Explorer Tree, you can use Shift click and Ctrl click to select multiple 
adjacent and non-adjacent elements respectively. 

The second Explorer Tree 

You can split the Explorer Tree into two trees, and then view different parts of your repository. 
You can drag and drop elements between the two. 

To split the Explorer Tree, click and drag the handle located at the bottom of the Explorer 
Tree's panel. As shown in the following image, the pointer changes to show that you can drag 
this up and down. 

 

The second Explorer Tree omits the user's own group (Administrator in the images), and 
instead starts from the Themes group. Knowledge Activation is also omitted from its 
Libraries group. 

 

To remove the split, drag the handle back to the bottom of the panel. 

Note: When you remove the second Explorer Tree, its state is wiped. When you next 
split the Explorer Tree, its tree will appear collapsed. 

The Explorer Tree toolbar 

The Explorer Tree has its own toolbar shown here: 
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The buttons are: 

 
Bookmarks. This toggles the Bookmarks Bar on and off. See The Bookmarks Bar 
on page 29 for more details. 

 
Find. Displays a Search box. See Search boxes on page 50 for general details on 
searching within Business Architect but note that the Explorer Tree's search 
includes a Recently Used filter. 

 
Options. A shortcut menu with the commands shown here. 

 

 
Window Position. Use this shortcut menu to pin and unpin the Explorer Tree. 

 

 
Filter. This lets you filter the Explorer Tree (filtered out items appear dimmed in 
the hierarchy). 

Click the Filter icon to select and apply a filter from a list of available filters. 

 

When a filter is applied to the Explorer Tree, filtered out elements appear dimmed. 

Filters vary depending on what you are doing, but can include: 

• Permissions to edit. Identifies elements that you have permission to edit. 

• Elements Allowed on Model. Elements allowed on the open model. 

• Variants. Use this to find elements that are variants of other elements. See Variants on 
page 139 for details on this type of element. 

• Elements allowed in Measures. Identify elements that can be measured by the 
measure type selected in the Performance tab (in the Explorer Tree, click Libraries, 
and then click Performance). 

• Off. Use this to remove filtering without closing the Filter box. 

Note: To remove filtering and close the Filter box, click the Filter button again. 
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The Bookmarks Bar 

The first button on the Explorer Tree's toolbar (shown highlighted in the main image that 
follows) toggles the Bookmarks Bar. This appears down the left side of the Explorer Tree. 
Bookmarks let you quickly access elements, or areas within Business Architect. 

 

The buttons are: 

 

User. For example, Administrator. Displays the user's Examine 
pane. If you are an administrator, you can use this to change your 
password. 

 

Favourites. Displays the Favourites pane. To add an element's 
model to your favourites, right-click the element or its model, and 
then select Add to Favourites. 

 

Recent. Displays a list of items recently opened in the workspace. 
This lets you quickly find and access items you recently worked on. 

 

Themes. Displays a pane where you can look through and search 
the models within your themes. 

 

Epochs. Displays a pane where you can look through and search the 
epochs (months, years, and other system or user defined periods of 
time) in your repository. 

 

Matrices. Displays a pane showing your matrix groups. 

 

Model Masters. Displays a pane showing your Model Master groups. 

 

Queries. Displays a pane showing your query groups. 

 

Smart Columns. Displays a pane showing your Smart Column 
groups. 

 

Styles. Displays a pane showing your style groups. 

 

Synchronizers. Displays the Synchronize tab in the workspace. 
This lets you access all your repository's synchronizers. 

  
 

The Explore button 

In Business Architect, you often want to quickly locate an item in the Explorer Tree. For 
example, you might see an element on a model and want to see what theme it belongs to, and 
where it is in the element hierarchy. To do this, use the Explore button to synchronize the 
Explorer Tree with the selected element. 

 

The Explore button can appear on the ribbon (in the Home command tab), in an element's 
Examine pane, or on an element's context menu. It always uses the same icon. 
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The workspace 
Below the ribbon, to the right of the Explorer Tree, is the workspace. Here you open and work 
on items in your repository, including elements, models, matrices and queries. 

You can have more than one item open in Business Architect. Tabs appear along the top of the 
workspace for each item open. Use these tabs to switch between them. 

Note: You cannot float workspace tabs. 

An asterisk on a tab means that that item has unsaved changes. 

 

The down arrow at the top-right of the workspace (ringed in the preceding image), or Ctrl W, 
displays a gallery of open items. For example: 

 

You can also use Ctrl Tab to display this dialog box and cycle through the available pages. 

Multiple workspace areas (tab groups) 
By default, the current item fills the available workspace. However, you can divide the 
workspace into two areas (called tab groups) either horizontally or vertically, and thereby 
display two items side by side. To do this, on the View tab, in the Tab Groups group, click the 
New Horizontal Group button or the New Vertical Group button. 
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The workspace divides, and the current item appears in the new tab group. 

 

Note: You can also click and drag an item's tab to the right edge or bottom edge to 
create a new vertical or horizontal tab group respectively. Business Architect 
outlines the area where the new tab group will appear. 

 

Each tab group can display more than one item (tab). New items are opened in the tab group 
that has focus, and you can use the Move to Previous Group and Move to Next Group 
buttons to move items between tab groups. 

 

Note: Again, you can click an item's tab, and then drag it to the required tab group. 
Dragging the last item from a tab group removes the tab group. 

 

Also on the View command tab: 

• Zoom commands apply per tab group. 

• View and Show/Hide commands apply to all tab groups. 

• The Combine Groups button restores the workspace to a single area. 

The status bar 

 

The status bar in the bottom right corner of Business Architect's window can include the 
following. 

 
The position of the currently selected symbol. If multiple symbols are 
selected, this is the position of the first symbol selected (the symbol with 
the white selection points). 

 
The size of the currently selected symbol. The same multiple selection 
rules apply. 

 Current user. 

 Full screen (F11). 

 Spotlight Presentation. Opens Business Architect's presentation mode. 
This lets you view, arrange and present elements as a slide show.  

 Focus light (Ctrl+L and Esc to exit). Turns on a spotlight. Use this to 
highlight parts of Business Architect. For example: 
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The area outside the spotlight appears dimmed. Use the mouse to 
control the spotlight. Business Architect's functionality is still available, for 
example you can click buttons and follow links. Press Esc to exit spotlight 
mode. The preceding image also illustrates the same Focus Light 
command on the ribbon. 

 
Controls the level of zoom. 

 Current zoom. 

 Zoom to 100%. 

 Fit model to window. 

 

Note: Most of these commands are also in the View and Zoom groups on the View tab. 
This tab also lets you hide the status bar. 

 

Right-click the status bar to choose what is included on it. 

 

The secondary Examine pane 
Along the right hand edge of the workspace there is a hidden Examine pane for the currently 
selected element. This is the same information that you get when you right-click an element, 
and then choose Examine, or when you click Examine on the ribbon, or press F12. 
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To activate the hidden Examine pane, click the right hand edge. You can resize and pin the 
pane as required. See Using the Examine pane on page 64 for more details. 

Panes and docking/floating 
Business Architect includes panes that appear and then hide once used, or when you click 
elsewhere. Examine panes and Query panes are examples. As shown in the following image, 
click the Window Position button in a pane's top right corner, and then choose from Float or 
Dock as Tabbed Document to prevent the pane from hiding automatically: 

 

Note: You cannot float workspace tabs. 

Element definition window controls 
When the workspace is showing an element's definition (right-click an element, and then select 
Open), its workspace includes controls to help you view and navigate the element's place in 
the hierarchy. The following image shows these controls. 

 

If the element has a parent, it is shown on the left. This is followed by the name of the theme 
that the element belongs to. You then have the name of the element in a text box that allows 
you to rename it. This is followed by three buttons that drop-down to reveal the element's 
siblings, children, and variants (and originals) respectively. See More on elements on page 15 
for an explanation of the relationship hierarchy, and the terminology used in MooD. 

The Welcome page and repository shortcuts 
When you open Business Architect, the workspace includes a Welcome page. This page 
highlights when any licences are due to expire, and you can add shortcuts to elements or other 
resources in the repository. 
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To add a shortcut, drag an element onto the Welcome page's Shortcuts area. This creates the 
shortcut to the element's model if it has one or to the element's definition if it doesn't. New 
shortcuts are appended to the existing shortcuts, but you can rearrange them. 

Note: If a shortcut exists for an element that does not have a model and a model is 
subsequently added for that element, the shortcut updates to open the element's 
model. 
 
If Business Architect can't create a shortcut for a particular item, the pointer 
changes to show you that that type of shortcut is not supported and cannot be 
created. 

To override the default shortcut functionality, you can right-click a shortcut, and then choose 
from the options shown in the following image. 

 

You can access other aspects of the element, and you can change the tooltip or delete the 
shortcut. 

The Welcome page has a Welcome group on the Home tab as shown here: 
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Click Edit Message to add or edit any message included on the Welcome page. This displays 
the Edit welcome text dialog box. 

Click Arrange Shortcuts to reorganize your shortcuts. This command disables the shortcuts, 
allowing you to drag them to new positions. Once moved, click Arrange Shortcuts to re-enable 
the shortcuts and fix their positions. 

Performing repository management from the Welcome page 

Depending on your level of permissions, you can perform some repository administration 
tasks from the Welcome page. To see what options are available, click the icon that 
represents your repository. For example: 

 

 

Note: The Open Repository command means open another repository. This closes 
the current repository. 

Context menus 
Business Architect makes extensive use of right-click context menus. You can right-click most 
things, and then see a menu of possible commands. For example, the following shows the 
context menu for an element on a model: 
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If you select multiple items, the context menu shows valid commands for that group of selected 
items. 

Note: In the Explorer Tree, you can use Shift click and Ctrl click to select multiple 
adjacent and non-adjacent elements respectively. On models, both the Shift and 
Ctrl keys behave the same when used with the mouse to select multiple items. 

Navigation Bar 
Each symbol on a model has access to what we term a Navigation Bar. This is what appears 
to the top right of symbols when you select them. For example: 

 

The icon on this will vary as Business Architect remembers the last thing you accessed so that 
you can quickly access the same area (useful when you are repeatedly performing the same 
task on successive symbols). So if you click the icon, you access that area. If you click the 
down arrow to the right of the icon, the Navigation Bar extends to reveal all its areas: 

 

The icons are: 

 

Look Inside/Outside. Expands to let you access associated models. 

 

Follow Dependency. This drops down and lets you find related elements. From 
here you can do many things including: 
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• Insert, or insert and link, related elements to the model. For example: 

 

• Add new elements. You can see the Create A Child Element option in the 
previous image. 

• Add, insert and link relationships. For example: 

 

You can access forward and reverse relationships. 

 

Open. Displays the element's definition window as a tab in the workspace. 

 

Explore. Synchronizes the Explorer Tree with the selected element. 

 

Examine. Displays the element's Examine pane about the element's properties 
and relationships within the architecture. 

 

Style. Displays the Format Style dialog box. 
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Symbols are this point. See Selecting overlapping or layered symbols on page 
44 for information on this. 

How "Save", "Rename" and "Undo" work 
Each resource or element in a repository is uniquely identifiable, and can be referenced by 
many other items throughout the repository. Because of this, if you ever rename anything, that 
change is implemented immediately, and all internal references are updated. You cannot undo 
a rename. 

Other changes have to be saved, and can be undone. Undo applies per tab, and each tab 
remembers its undo history. The Undo button appears in the Quick Access Toolbar. 

 

If you don't see this button, see The Quick Access Toolbar on page 25 for details on 
customizing this toolbar to include the Undo button. 

The shortcut for undo is Ctrl Z. To reverse an undo, it is Ctrl Y. 

Note: When you add an element to another element's model, it immediately creates an 
association between the two elements. This cannot be undone by the Undo 
button. In this case, you must use the Remove command to remove the element 
you added from the model concerned. See How Remove and Delete work on 
page 39 for more details. 

An asterisk next to something indicates unsaved changes, for example, 

 

Within an element's definition (use Open to display this), additional asterisks show what parts 
(fields) have changed. You have two save commands: 

 Save 

 Save All 

If you close Business Architect with unsaved changes, it prompts you to save each unsaved 
item. 

 

 

Note: If you have many unsaved items, you can cancel one of these prompts and then 
use Save All. However, be careful if you have been making experimental changes 
during your session. You risk saving unwanted changes. 
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How "Remove" and "Delete" work 
In Business Architect: 

• Remove generally means remove an element from a model. Removing leaves the 
element in the repository. 

• Delete generally means delete the item from the repository. This removes any 
dependencies and relationships that item has. You cannot undo a deletion. 

Business Architect will typically prompt for clarification of your intention, and will always prompt 
you to confirm a deletion from the repository. For example, when you remove an element from 
a model, you will see the following dialog box (unless you have previously selected the check 
box to always remove). 

 

Tip – Previewing the impact of a deletion 

Before you delete an element, you can see where it is used. To do this, right-click an 
element, and then click Show Where Used. This displays the Used By dialog box. 

Difference between "Open", "Examine", "Look Inside", 
"Look At" and "Explore" 
In Business Architect: 

• Open 

 

Displays the element's definition window as a tab in the workspace. This is how you see 
the element's fields. 

• Examine 

 

Displays the Examine pane about the element's properties and relationships within the 
architecture. F12 is the shortcut for this. 

So whereas Open lets you see what an element is, Examine lets you see how an 
element is used. For instance, Examine lets you see all the models that the element 
appears on. See Using the Examine pane on page 64 for more details. 
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• Look Inside 

Displays the element's model. If the element does not have a model, you are prompted 
to create one. There may be a choice of model types. 

Look Inside is on an element's shortcut menu along with Look At. 

 

• Look At Type of Model 

Displays, or prompts you to create, the named model type. Depending on an element's 
theme, it can have more than one type of model. 

• Explore 

 

Synchronizes the Explorer Tree with the selected element. Use this to quickly locate an 
element within the hierarchy. This function is always represented by the icon shown. 

Note: You can change some of the default functionality described here. See Business 
Architect's options on page 25 for an introduction to what's possible. 

Selecting, formatting and arranging symbols on a model 
Before you can format symbols on a model, you need to select them: You can: 

• Click a symbol to select it. 

When a symbol is selected, it has selection points as shown here: 

 

Use the selection points to resize and rotate an item. The pointer changes to show what 
happens when you click and drag each point. For example, the next image shows the 
rotation selection point. 

 

Note: Red selection points mean the symbol is locked and cannot be moved, 
resized, rotated or reshaped. 

When a symbol is selected, you can drag it with the mouse, and you can use the arrow 
keys to move it slightly in a given direction. 

• Click, hold and drag a virtual rectangle to encompass one or more symbols. As the box 
encloses symbols, they become selected, and the available formatting options apply to 
the selected symbols as a group. 
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For example, when multiple symbols are selected, you can use the Arrange, Layout 
and Size commands on the ribbon to collectively size or organize the selected symbols. 
The Layout gallery is shown here: 

 

Note: When more than one symbol is selected, the first one you select has white 
selection points. This is because some formatting options are relative to 
the first symbol selected. If this is important to you, the next selection 
method may be better for you. 

• Press and hold the Shift key or Ctrl key, and then click the symbols you want to select. 
The items remain grouped until you click outside of the selected symbols' selection 
points. 

• Use the Select command on the ribbon. On the Home tab, the Layout group includes 
the Select command. This displays the Selection pane: 
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Use this to select a category of symbols. Use the Ctrl key to select multiple categories, 
and click the eye icon to show or hide that category (dimmed means hidden). 

Note: On the Selection pane, use the Timings command to see how resource 
intensive a model is. See Model Timings on page 46 for details. 

The selection methods covered here illustrate some of the formatting options you have. Most 
formatting options are on the ribbon. The Home tab's Font, Drawing and Layout groups 
contain all your formatting options. These can be seen in the following image (note that it has 
been altered to exclude the Insert group). 

 

Some of the commands on the ribbon give you lots of formatting possibilities. For example, in 
the Layout group, the Arrange command includes a variety of commands to arrange what is 
currently selected on the model. The next image illustrates this. 
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In addition to the Home tab, the ribbon includes a Layout tab that includes many of the same 
commands. As shown in the next image, this provides an alternative to the Home tab. 

 

As an alternative to the ribbon, if you right-click a symbol or group of selected symbols and then 
click Format Style on the shortcut menu, you get the Format Style dialog box for the selected 
symbols. 

As shown in the following image, the same shortcut menu includes a Draw command. Use this 
to position the selected symbols. Again, this is an alternative to the ribbon. 
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Finally, as shown in the following image, the status bar shows the screen position and size of 
the selected symbol. If more than one symbol is selected, these relate to the first symbol 
selected (the one with white selection points). 

 

Business Architect's Model Editor Options settings 

Business Architect's Options dialog box (File tab, Options) includes a Model Editor 
Options group of settings on its General tab. These affect how selecting and formatting 
function. This guide describes the default functionality, but you can tailor the working 
environment to suit your preferences. For example, there is a Moving a symbol also moves 
its attached panels check box. If this is selected, when you select and move an element's 
symbol, any panels pinned to that element also move. See Business Architect's options on 
page 25 for more details on what features can be configured. 

Selecting overlapping or layered symbols 
On a model, if you have symbols that cover each other, use the Navigation Bar's Symbols at 
this Point feature: 

 

For example, the text box shown in this next image covers three other symbols. The context 
menu lets you select the required symbol. 

 

To quickly access the Symbols at this Point details for any point on a model, use Alt left-click. 
This immediately displays the Navigation Bar in Symbols at this Point mode. 

The Model tab (page setup and grid) 
The Model tab includes basic settings that affect how you create and format models. 

• Use the Page group of commands to control page setup and orientation. 
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• Use the Grid button in the Guides group to control how the grid appears and functions. 

 

The top half of the ‘Grid’ button toggles the grid on an off. 

Pickup and Apply 
On the Home tab, in the Drawing group, the Pickup / Apply button lets you pickup the 
formatting on one symbol and then apply it to another. 

 

Task 1 To use the Pickup / Apply command: 

1. On a model, click the symbol that has the formatting you want to apply elsewhere. 

This selects the symbol. 

2. On the Home tab, in the Drawing group, click the top half of the Pickup / Apply button. 

 

This picks up the selected symbol's formatting. 

3. On a model, click the symbol that you want to apply the formatting to. 

Note: This does not have to be the same model that you picked up from. 

4. Click the bottom half of the Pickup / Apply button. 

This displays the menu shown here: 
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5. Click the formatting that you want to apply to the selected symbol. 

The formatting is applied. 

Note: The Pickup / Apply button remains loaded with the last set of formatting 
picked up. 

See the Styles section on page 117 for more information on how you can also use named 
styles within models. 

Conditional formatting 

You can conditionally format symbols based on an element's Pick list values. For example, you 
could make items deemed critical appear bold and in red. To configure this, on the ribbon, on 
the Home tab, in the Drawing group, click Conditional. This displays the Conditional 
Formatting dialog box. 

Model timings and testing performance 
Business Architect lets you see how resource intensive a model is. You can see the number of 
milliseconds it takes for items such as matrices and charts to load. This is particularly useful if 
you are creating models that will be deployed on the web using Active Enterprise.  

When a model is displayed, the Model tab includes a Timings command in the Show group.  

 

The top half of this button displays the Selection pane's Timings section. 

 

 

Tip 

If something takes a long time to load and it uses queries, you should look at the efficiency of 
those queries. Query Builder has its own test and performance tuning features. See Creating 
a query on page 74 for details and some tips for faster queries. If the bottleneck is an 
aggregation, consider using aggregation caching (an Aggregation Performance guide is 
available in the Support Area at www.moodinternational.com). 

Flipping panels 
On models, you turn over (flip) Info, graph and action panels to access their settings. You then 
flip the panel back to see the changes made. 
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If the Flip button is red, a panel needs further configuration. In most cases, an exclamation icon 

 next to a tab or setting indicates where the issue is. 

Note: Typically, the flip side contains settings that affect the panel's content. Settings 
that affect appearance are generally on the ribbon. 

When multiple panels are selected, flipping one flips them all. To flip them all back, press F9. 

Pinning (green, blue and orange pins) 
Pinning is how you connect panels and their inputs. Pins enable interactions: 

• Green pins show the panel's subject element. When viewing a model's pin connections, 
a dotted green line means that the subject element has been implicitly set (assumed). 
Explicitly set subject elements have a solid green line. 

• Blue pins show elements that can refresh the panel. For example, you will often blue 
pin items to Button action panels. 

• Orange pins show elements that are the source of a variable used in a query that 
defines the panel's content. So when a panel's Information Shown is set to a query 
that takes variables, those variables are listed on the panel's Inputs tab where they can 
be pinned to whatever will provide their value. 

Pins are typically used to drive content, and to make models interactive when deployed on the 
web using Active Enterprise. Here are examples: 

• You have a model with three element symbols on it. You want an Info panel to show 
information about one of these elements. Here you flip the Info panel and green pin the 
Subject of panel to that element, as shown in this image. This is pinning at its simplest. 
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• You have a page (model) that shows project information on some Info panels, matrices 
and charts. You want the user to select a project from a drop down list and update the 
page to show content for that selection. Here you pin the Info panels, matrices and 
charts to the drop down list so that they use what is selected in it and refresh when that 
selection changes. 

• You have a Documents synchronizer that generates a report. The subject of the report 
is set by a variable that has been passed upwards so that it is exposed for pinning. You 
want to use this synchronizer to generate a report for the element being viewed on a 
Model Master. Here, the Model Master will include a button that executes the 
synchronizer. The button's Inputs tab will include the variable that the synchronizer 
needs. You pin this to the Model Master's primary symbol. Hence the report will be 
generated for the element currently being viewed. 

 

 

You drag pins onto symbols or other panels. This pins that value to that target or source. If 
there is a choice of targets, you choose the required one. For example, as shown in the next 
image, when you drag a pin onto a Session Variable panel, Business Architect prompts you to 
choose which one. 

 

Beside the pin on the reverse of a panel, there is a Wand icon. This Wand icon produces an 
intelligent list of the types of panel that may be created to support this type of input and, an 
intelligent list of the potential pin targets that already exist on that model. 
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Note: Session variables let you preserve user's selections across pages in a web 
solution. They are not covered in this guide but a video is available in the Support 
Area at www.moodinternational.com. If you are developing web solutions, you will 
frequently pin to session variables. 

To see what pins are on a model and how they interact, use the Pins command (on the ribbon, 
on the Model tab, in the Show group). 

 

When Show Pin Connections is selected, you can click anything on a model and see what it 
is pinned to, for example: 

 

On the Model tab, select Hide Flipped to temporarily hide flipped panels when you are 
dragging a pin. This can make pin positioning easier. As soon as you drop the pin, the flipped 
panels reappear. 

 

Alternatively, users can flip a panel that has been pinned and click on an empty pin hole to 
"unpin" or "show pin". Note that this is for the selected panel only, whereas the ribbon options 
control all panels on the model. 

http://www.moodinternational.com/
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There will be occasions when it is possible and desirable to connect many pins. Rather than 
doing each pin individually, you can do it in one operation. To do this, press and hold the Ctrl 
key as you drop a pin. This will give you a list of valid possibilities: 

• For green and blue pins (subject and action pins), you get a menu like the following: 

 

• For orange pins (variables), you get a dialog box like the following: 

 

Searching 
In Business Architect you have: 

• Two types of search facility: simple Search boxes, and the more detailed element 
Search available in each element's Examine pane. 

• Filters to help you find and select items from a reduced list. 

• List styles to present lists of items in a display format you like. 
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Search boxes appear in many places. All Search boxes function the same way. Whatever you 
are searching reacts to show what matches the text entered in the Search box. For example, 
here is the Search box in a Query pane. 

 

Filters 

You can filter many lists. Filters always appear in drop-down lists, and the available filters are 
fixed. For example, the Matrices pane has a number of filters (Matrix Type, Cached, and 
Modified) as shown here: 
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Similarly, the Queries pane has a range of filters (Input, Output, Modified and Parameterised) 
as shown here: 

 

 

 

Note: The initial filter always restores the unfiltered list. 

List styles 

Many things in Business Architect appear in lists. To view a list in a format that suits you, you 
can usually select a list style by means of buttons or a menu. Both are shown here: 
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Favourites 
You can mark elements as favourites, and then access them quickly from: 

• The Explorer Tree's Favourites item. 

 

• The Bookmark Bar's Favourites button. 

 

Both open the Favourites pane. 
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Note: The Favourites pane is, like most panes, unpinned. Once used, or if you click 
elsewhere, it hides itself until you access it again. This maximizes your available 
workspace. However, you can pin the Favourites pane to the workspace, for 
example, if you want to use it several times, or if you want to rearrange your 
Favourites. 

 

Favourites are organized into groups. You can: 

• Add, rename and arrange groups. In the Favourites pane, right-click a group title or 
white space, and then use the shortcut menu. 

 

• Drag Favourites between groups. 

To mark an element as a Favourite, you can: 

• In the Explorer Tree, right-click an element, and then click Add To Favourites. Then, if 
you have groups, select the group from the sub menu. 

 

• If you want to add the currently active element as a Favourite, open the Favourites 
pane, and then use the Plus button. 
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• Open and pin the Favourites pane, and then drag an element from the Explorer Tree 
into a group. 

 

Note: Use this method if you want an element to appear as a favourite in more 
than one group. 

 

To remove a favourite, in the Favourites pane, right-click the favourite, and then click Remove 
From Favourites. This is shown in the following image. Alternatively, use the Minus button 
(visible in the previous image). 

 

 

Note: Removal in this context only removes the favourite status. It does not remove the 
element. 

Spotlight mode and presentations 
Business Architect includes a presentation application called Spotlight. If you open Spotlight 
from within a Favourites group, you access slides for each of the models in that group. Slides 
are ordered in the same way as the elements in the Favourites group. You can format slides, 
and save them as Microsoft PowerPoint presentations. 

You can also use Spotlight to present a model full screen. 

To open Spotlight, do one of the following: 

• In the Favourites pane, click Spotlight. 

• On the ribbon, on the Model tab, in the Page group, click Spotlight. 

Both are shown in the following image. 



MooD 16 Getting Started Guide 
 

 56 

 

Tip 

When a model is in the workspace, the Home tab has a Capture button. 

 

This copies an image of the active model into the Windows clipboard. You can then paste 
this image into other applications. 
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Elements in Business Architect 
Elements are the building blocks of business models in MooD. This section covers: 

• Building an element hierarchy 

o Relationships between elements (relationship fields) 

o Measures on elements (measure relationship fields) 

o Tip – Benefit of # root elements 

• Viewing information about an element (page 63) 

o Using the Examine pane 

• Setting an element's fields (page 65) 

• Creating and viewing models (page 66) 

• Adding elements to a model (page 67) 

• Linking elements on a model (page 68) 

o Adding bends to lines 

o Formatting the ends of lines 

• Formatting elements on a model (page 70) 

See Element in the Key concepts section (page 14) for a general introduction to elements and 
their place within MooD. Also, as you develop your understanding of elements, you may need 
to refer to the Business Architect's user interface topics (starting on page 22) for information on 
particular features or processes. 

Building an element hierarchy 
Elements form the hierarchy within a business model. 

The Explorer Tree's Themes section shows this hierarchy. 

 

Each theme defines the types of element that you can create within that theme. You create 
elements in parent-child relationships starting from the theme. 

For example, in the preceding image, the Processes theme has three child Process elements, 
one of which (Athena), has two child Process elements. 
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In the Explorer Tree, when you right-click an element, the context menu includes a New 
command. This creates a new element as a child of the element that you clicked. Use this 
mechanism to create elements and build a hierarchy. 

 

This means that to create sibling elements, you add new elements to the parent element until 
you have the required number. 

 

Note: Universal themes support several element types. When you click New, 

you choose from the available types. For example: 

 

 

Once you have a hierarchy, you can drag elements and re-parent them within it. The Explorer 
Tree lists sibling elements alphabetically. Business Architect will only let you move elements to 
valid positions in the hierarchy. 

Other ways to create elements 

You can also create elements automatically using a synchronization, or when modelling by 
means ribbon, mouse and Navigation Bar. Each of these is outlined here. 

Using synchronizations 

Synchronizations are frequently used to import data into a theme and recursively create or 
update elements. For example, the Microsoft Excel Import synchronizer is commonly used to 
import data from a spreadsheet. See Synchronizations in the Key concepts section (page 20) 
for an introduction to this technology, and SAT on page 143 for details on where 
synchronizations are in Business Architect and an example illustrating the Microsoft Excel 
Import synchronizer. 

Using the Elements command on the ribbon 
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When a model is displayed, the Home tab includes the Elements command. 

 

Use Elements to: 

• Create a new child element (child of the model's subject element). In the gallery, 
when you click within New Child Element, the pointer changes to: 

 

When you click the model, the element's symbol is added to the model, and an 
element is inserted into the hierarchy as a child of the model's subject element. 

• Add another element of any supported type. Choose from the gallery under Add 
Element of Type. The pointer changes as before. However, as shown in the 
following image, you can then select from a list of existing elements, or, if permitted, 
create a new one (type a name in the Search box to enable the New button). 

 

If the new element is the same type as the model's subject element, it is created as a 
sibling of the subject element. 

Using the Ctrl key with the mouse and an existing symbol on a model 
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If a model already includes element symbols, you can use the Ctrl key with the mouse to 
create new elements or add existing elements. 

• If you press and hold the Ctrl key and then click and drag an unselected child of the 
model's subject element, it creates a clone of the child element on the model and in 
the element hierarchy. We recommend that you rename clones. 

Note: This cloning technique does not work with elements in the Explorer Tree. 
For this area you can use variants. See Variants on page 139 for 
details. 

• If you Ctrl drag a symbol that does not represent a child of the model's subject 
element, it functions like the Add Element of Type gallery described in the previous 
section, that is, you can choose to add an existing element, or, if permitted, create a 
new one. 

Note: Ctrl drag on the subject element's symbol just moves the symbol, and Ctrl drag 
on a panel creates a duplicate of that panel. 

Using the Navigation Bar 

The Follow Dependency option lets you add elements when modelling. See Navigation Bar 
on page 36 for more details. 

 

Relationships between elements (relationship fields) 
The element hierarchy covered in the preceding section refers to inherited (parent child) 
relationships between elements in a theme. 

Note: See Relationship (page 16) in the Key Concepts section for an overview of non-
hierarchical relationships in MooD. 

Elements can also have explicit non-hierarchical relationships with other elements by means of 
relationship fields. For example, a Project element might have a relationship field linking it to 
Team elements, as shown here: 
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These relationships can be within or between themes. In Manage Themes this type of 
relationship is defined as a standard relationship (the other type called measure relationship 
is outlined in the next section). 

The definition of a relationship in Manage Themes includes the nature of the relationship, the 
fields the relationship itself can have, and rules governing what elements (themes) can satisfy 
the relationship. Like many things in MooD, you drag elements into a relationship field and, 
provided the conditions are satisfied, the connection is made. On models, you can create 
specific relationship links between elements connected by a relationship field. 
Synchronization also supports the automated creation of relationships. 

Opening and finding relationships in Business Architect 

To open an individual instance of a relationship, for example, to see any fields on that 
relationship, in the element's relationship field, right click the column at the very start of the 
field. For example: 

 

opens: 
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In queries, if you want to find these instances of a relationship, tick the find intermediate 
relationship elements check box, as shown here: 

 

In the example, if this check box were not selected, the query would return the Team 
elements (Alpha etc.) at the end of the relationship. 

Measures on elements (measure relationship fields) 
Following on from standard relationships between elements, you have measure relationships. 
Again these are defined as part of the meta-model definition in Manage Themes. If an element 
can have a measure applied to it, it will have a measure relationship field. For example: 

 

Again you can drag a measure into this field to create specific measure instances for that 
element, and synchronization can be used to create and populate measures. 

Benefit of # root elements 
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In practice, when developing solutions, MooD International use universal themes, and for 
each element type have a root element called #typeName. For example, if you have a 
Projects theme with a Project element type, you would have a root element #Project. 

Why we do this: 

• Clarity. It is useful for all elements of a particular type to be descendants of a 
#typeName element that names their type. 

o Queries on a type can then start from the #typeName element and use Find 
Children or Find Descendants as appropriate. 

• Organization and protection against unwanted deletion. For example, consider 
making all the matrices for a particular element type belong to its #typeName 
element. Alternatively, consider having a #MatrixContainer element for all matrices. 
This makes matrices easier to find and helps prevent their unintentional deletion (as 
users will be understandably careful about deleting anything with # in its name). 

• Setting Permissions. Permissions are best set at the #typeName element and 
inherited wherever possible. 

Viewing information about an element 
In the Explorer Tree, right-click an element, and then click: 

• Open to see the element's fields. This is displayed as a tab in the workspace. 

• Examine to see information about the element's place and function in the architecture, 
including what models and matrices it has or is used in, its dependencies, and its 
permissions. This is displayed in an Examine pane, for example: 

 

See Using the Examine pane on page 64 for more information on this pane. 
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• Look Inside to see the element's model. If the element does not have a model, you are 
prompted to create one. Models are displayed on tabs in the workspace. 

• Show Where Used to see where the element is used. This is displayed in a Show 
Where Used dialog box, for example: 

 

You can open multiple Show Where Used dialog boxes and you can right click items 
and access their context menus. 

Note: When an element is selected in the Explorer Tree or on a model, both Open 
and Examine are also available on the ribbon. 

 

Using the Examine pane 

The Examine pane is used throughout Business Architect. It gives you access to everything 

linked to, or related to, an element. It is organized into categories. Click the  buttons to 
display more about each category. For example, the next image shows the effect of going into 
the Models category. 



MooD 16 Getting Started Guide 
 

 65 

 

Use the left arrow button  to return to the category list. 

The icons along the top of the Examine pane are: 

 
Explore. Synchronizes the Explorer Tree with the element. 

 
Open. Displays the element's definition as a tab in the workspace. 

 
Model. Displays the element's model as a tab in the workspace. If no model 
exists, the Create Model dialog box is displayed. 

 
Permissions. Displays the Permissions tab for that element. 

The shortcut for the Examine pane is F12, and the Examine pane opens at the last category 
viewed. So, for example, if you are looking through the dependencies for several elements, you 
don't have to navigate through the categories each time you open the Examine pane. 

Setting an element's fields 
Business Architect presents elements and their contents clearly and consistently. 

Task 2 To set an element's fields: 

1. In the Explorer Tree, right-click the element, and then click Open. 

This displays the element's definition as a tab in the workspace. 

The element's fields are listed on the left. The same list of fields appears on the right 
along with their current settings. 

2. In the list of fields on the left, click the name of a field. 

The field is highlighted and, on the right, the same field is highlighted and expanded to 
show its current setting. For example: 
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3. Set the field to the required value. 

Fields vary. To help you: 

• Some fields take text (these are known as formatted text fields). Just click and type. 

Tip 

If you right-click a formatted text field, you get a shortcut menu of text commands, 
for example Bold, Bullet, Font and Align. 

• Some fields are Pick lists, or controls such as calendars. Use the control to enter or 
change the value. 

• Some fields take elements. You can drag elements from the Explorer Tree, or find and 
add elements. 

Tip 

Whenever you see an element listed in a field setting, you can right-click it and 
find out more about it. For example, you could use the Explore command to sync 
the Explorer Tree with that element, or the Look Inside command to see its 
model.  

Whatever the type of field, it is designed to help you see and understand its setting. In 
addition, Business Architect will not let you set fields to nonsensical values. 

4. Save your changes. 

An asterisk next to a field or on the element's tab means that the element has unsaved 
changes. 

In practice, elements and their fields are often populated and updated using synchronization. 

Creating and viewing models 
Models elaborate elements. For example, if you have a Process element, a model of the steps 
involved in that process is very informative. Models also form the user interface in web 
solutions deployed using Active Enterprise. 

Creating a model and viewing a model is the same basic process, because, if you try and view 
a model and it doesn't exist, Business Architect will either create one, or prompt you to confirm 
that you want to create one. 

Task 3 To create or view a model for an element: 

1. Do one of the following: 

• In the Explorer Tree, double-click the element. 
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Note:  This is the default double-click behaviour. However, you can alter this. 
See Business Architect's options on page 25 for details on altering the 
defaults. 

• Anywhere, right-click the element, and then, on its shortcut menu, click Look Inside. 

Note: Some elements may also have a Look At Type of Model command. 

Business Architect displays the model as a tab in the workspace, or prompts you to 
create a model. 

2. If prompted, confirm the creation or choose the model to create. 

Business Architect creates the model and displays it as a tab in the workspace. A newly 
created model might be blank apart from the element itself, or it can already include 
content from its Model Master if one is automatically applied. See Model Masters on 
page 123 for more details. 

Adding elements to a model 
When you construct a model for an element, you are likely to add other elements to the model. 
Business Architect lets you do this in a number of ways. These are covered in this task. 

Task 4 To add elements to a model: 

1. Open the element's model. 

See Creating and viewing models on page 66 for details on this first step. 

2. Do any of the following: 

• In the Explorer Tree, or in any pane listing elements, click the element and drag it onto 
the model. 

Note: In the Explorer Tree, you can use Shift click and Ctrl click to select 
multiple adjacent and non-adjacent elements respectively. 

• Use the ribbon. On the Home tab, in the Insert group, click Elements, and then use 
the gallery. 

 

• Use the Ctrl key with existing model symbols and the mouse to add new or existing 
elements. See the Other ways to create elements info box within the Building an 
element hierarchy section (page 58) for details on how the Ctrl key functions (it varies 
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depending on what you select on the model). Also note that Ctrl drag on a panel 
creates a duplicate of that panel. 

• Select any element already on the model and use the Navigation Bar to add (Insert) 
or add and link (Link) related elements with a variety of layout options. For example: 

 

See Navigation Bar (page 36) for general details about using the Navigation Bar. 

• In the Explorer Tree or on the model, right-click the subject element (or any element), 
and then click Examine. 

This displays the element's Examine pane. Use its Dependencies list to find 
elements that you might want to add to the model. 

Linking elements on a model 
When you construct a model, you will link elements (or any items on a model). Business 
Architect makes linking simple, and preserves links when you move linked items. 

Task 5 To link two Items on a model: 

1. Open the element's model. 

See Creating and viewing models on page 66 for details on this first step. 
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2. On Home tab, in the Insert group, click Links. 

This displays the link gallery. 

 

Note: The types of link available depend on the type of model you are working 
on. Each type also affects what happens. For example, if you are drawing 
a Relationship link, you'll be prompted to select the relationship (adding a 
relationship link does more than draw a line – it creates the actual 
relationship). In all cases, the user interface will guide you. This task just 
draws a Line link. 
 
The Automatically Connect Related Elements command draws links 
between relevant symbols already on the model. You can use the 
Navigation Bar to add and link related elements at the same time. See 
Navigation Bar (page 36) for details. 

3. Click the type of link you require. 

When over the model, the pointer changes to a pencil icon. 

 

Note: To cancel this at any time and get the normal pointer back, press the Esc 
key. 

4. Click the first item you want to link. 

A link attaches itself to the nearest attachment point, and the mouse pointer is bound to 
the link's pointed end. The link now moves with the pointer. 

 

Note: The attachment point on the first item may change as you move the 
mouse. Business Architect tries to provide the most efficient attachment 
point. Once the link is in place, you can move either attachment point. 

5. Move the pointer to the item that you want to create a link to. The attachment point that 
will take the link is highlighted in red. 
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6. Click to link the two items. 

The two items are linked. 

Depending on the type of link, you may be able to label it. 

Double-click to terminate free-standing lines (lines that do not end at an attachment 
point). 

If the pointer still shows the pencil icon and you do not want to add another link, press 
the Esc key to return it to its normal appearance and functionality. This will also delete 
any unterminated links. 

To format a link on a model, right-click it, and then click Format Style. This displays the 
Format Style dialog box for the link. Other line formatting options are available on the ribbon or 
from the line's Navigation Bar and the next two sections cover bends and end points. 

Adding bends to lines 
By default, Business Architect draws straight lines. If you want to insert bends, select the line 
and right click one of its selection points. A new point is inserted between the existing points. 
You can then drag this to form the curve. For example, the following images show a fourth point 
being added to an already curved line. 

 

Gives you: 

 

By default, bendy lines are Spline (smooth curves). The Line Shape setting also gives you: 

• Polyline. For example: 
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• Orthogonal. For example: 

 

Formatting the ends of lines 
MooD lets you choose between numerous end points including ones that comply with IEDM 
Crow's Foot notation. Start and end points are also colour coded. To set the end points, right 
click a selection point and use the Begin Arrow and End Arrow settings. 
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If you right click either end of a line, you only get to choose that particular line terminator (the 
menu will only have the relevant Arrow setting). If, like the preceding image, you right click a 
selection point in the middle, you get both Begin Arrow and End Arrow. 

Formatting elements on a model 
As you construct models, you can apply formatting to everything that appears on them, not just 
elements. Hence, you'll find formatting discussed in general terms throughout this guide. When 
a model is open in the workspace, the Home and Layout tabs include comprehensive 
formatting options, while the Model tab has basic page setup features. Most of these are 
covered in the Selecting, formatting and arranging items on a model section on page 40. This is 
followed by sections on The Model tab (page 44), Pickup and apply (page 45) and Conditional 
formatting (page 46). Features you may also want to make use of when formatting are Styles 
(page 117) and Model Masters (page 123). 
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Key features in Business Architect 
This section covers using some of the some of the key features in Business Architect. 
Specifically: 

• Queries (page 74) 

• Info panels (page 82) 

• Smart Columns (page 87) 

• Matrices (page 102) 

• Graph panels (page 110) 

• Action panels (page 113) 

• Styles (page 117) 

• Model Masters (page 123) 

• Measures (page 136) 

• Variants (page 139) 

• SAT (the Synchronize library) (page 143) 

• Knowledge Activation (page 145) 

• Active Enterprise (page 147) 

• Introducing administration (page 149) 

• Introducing Manage Themes (page 151) 
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Queries 
A query finds elements. See Query in the Key concepts section (page 18) for more general 
material on queries. This section describes how to create and use queries in Business 
Architect. 

Note: A video introducing queries and Query Builder is available within the Support Area 
at www.moodinternational.com. 

Queries are reusable items that can be organized into groups. Hence, in the Explorer Tree, 
they are listed under Libraries. 

Tip – Organizing your library 

In practice, when developing solutions, MooD International organizes queries into logical 
groups and uses a numbering system that relates to the element type returned. For example, 
you could have a group and naming convention 01.xx for queries relating to Project 
elements, 02.xx for Team elements, and 00.xx for generally useful queries. 

In addition, spend some time on your naming conventions and query summaries. Will 
someone new to the solution understand its queries? 

If you click a query, and then click Open, it opens that query in Query Builder. Query Builder 
occupies a tab in the workspace. Use it to construct and test queries block by block. 

Creating a query 

The following task illustrates how to approach adding a query. 

Task 6 To create a query: 

1. In the Explorer Tree, under Libraries, click the  button next to the query group that 
you want to add the new query to. 

This selects the query group, and displays its Queries pane. 

2. In the Queries pane, click New. 

This adds a query called New query, and selects its name. 

 

3. Give the query a descriptive name. 
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4. Click the query, and then click the Open button: 

 

A tab opens in the workspace. This is Query Builder. 

 

5. Configure the query. 

The following should help you: 

• All queries have a starting block. This defines where your query begins. 

 

Starting blocks can have where clauses that add qualifying conditions. For example, 
you might want a query to only return elements with a particular status, as shown in 
the following image where the risk High is set as a condition: 

 

You can add multiple where conditions. 

• On the right of Query Builder, you have several categories of Find block that you can 
drag underneath the starting block to build the query (double-click also adds them). 
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These are the things that the query will look for in relation to the elements returned by 
the starting block. 

 

You have the following categories of Find block: 

 
Relative positions in the element hierarchy. For example, 
Find Children. 

 

 

Measures. For example, Find Instances from Container 
Element. The ones with an icon beside them return 
actual measure instances. The others return some 
information about measure instances. 

 

 

 

 

 

 

Relationships attached to the elements or measure 
instances. Anything with Used By in its title is a reverse 
relationship (unless the default names given to reverse 
relationships have been changed in Manage Themes). 

In a relationship Find block, if you select the find 
intermediate relationship elements checkbox, the block 
will give you the instances of the relationship and not the 
elements at the end of the relationship. 

 Queries. 

 

 

 

Miscellaneous. Other categories of Find block, including 
element relationships, models, variants, events and 
epochs. For example, it includes Find sibling epochs 
that gives you the other months in a year. 

 

 

 

 

 

Terminators. Queries can end in an And Finally block. 
This lets you, for example, order the results, or only return 
the top N matches (N can be a number or a variable). 

If you want to use the query in an aggregation, don't 
include an And Finally block (any sorting is done in the 
aggregation). 

You can add multiple Find blocks. Each Find block acts on the results of its 
predecessor. 

You can use the Filter blocks check box to see what is valid at any particular point. 
For example, if your query currently finds measure instances, the Measure blocks 
with icons against them will be greyed (disabled) because they return measure 
instances. 

• Use the Test button on the ribbon, or click the Test tab in Query Builder, to test your 
query as you construct it. 
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The Test tab lists the elements returned by the query. 

You can also see or access the number of elements found by each step in the query. 
An empty box means that the result at that stage has been withheld to make Query 
Builder more efficient. To see a withheld interim result, click its empty box. 

The  icon indicates that the query is optimized at that point. If these don't appear, 
you should investigate whether you can make the query more efficient. Some tips are 
included in the next info box. 

Note: On the ribbon, the Home tab has some more advanced testing/tuning 
facilities. These are in the Performance Tuning and Advanced 
command groups. 

Tips for faster queries 

To improve performance: 

• The starting block should involve as few elements as possible. The most efficient 
starting point is the parameter, followed by elements, the results of query, and 
then type. The all elements except and everything settings are the least efficient. 

o When using the parameter, use a where type condition to stop users executing 
queries over more elements than necessary. You should always try and restrict 
the breadth of a query. 

o When using the results of a query you can select a query (or other block) from 
the Picker - accessed by clicking on the Search icon - rather than dragging a find 
block from the right-hand panel. 

 

 

 

o When starting from a variable, be careful with the Ignore Variable setting. You 
can end up searching across the entire repository. 

• Conditions and their order can significantly affect performance. If a chain of 

conditions does not show the optimized icon  at each point, experiment with their 
order and try to get the optimized parts of the query nearer the top of the chain. You 
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can also attempt to restrict your query to conditions that lend themselves to optimized 
performance. These include: 

o where conditions based on name (excluding measure instances), type, parent, 
children, reference, and the contents of simple type fields. 

o Find blocks that find children, parents, descendants, and reference/referenced by. 

o When ordering conditions, put the following as early as possible in the query: 

o AND conditions that are most likely to fail. 

o OR conditions that are most likely to succeed. 

• If using sub-queries, consider the performance of each, and pay particular attention 
to condition ordering when sub-queries are AND'd or OR'd together. 

o And Finally blocks and the Take Top N condition can stop sub-queries being 
optimized. 

Using queries 
Once you have a query, you can use it in any place that can take a query, for example, to 
return the elements that form the columns in a chart. The Select Content dialog box includes 
Queries as one of its categories (ringed in the following image): 

 

When something uses a query, you are typically given an Edit this query option to quickly 
display that query in Query Builder. For example, the following shows an Info panel's flip side 
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with Information shown set to a query (called Projects), and the resultant Edit this query 
option: 

 

Parameters and variables in queries 
Parameters and variables are what make queries one of the most useful features in MooD. 

Parameterized queries take a parameter as their starting point (one of the starting blocks is the 
parameter). This means you can use the same query again and again with different subject 
elements as the starting point each time. For example, you could have a parameterized query 
that returns all the tasks assigned to a person. The same query could then be used with any 
person element. 

Parameterized queries have a yellow dot on their icons: 

 

Tip – Developing 'the parameter' queries 

When developing reusable queries, although Query Builder does let you set a test element 
for the parameter, it can be helpful to develop your query from a known element with known 
results. Once you know that the query does what you want, you can change the starting 
block to the parameter. We have found this approach useful during introductory training. 

A query can include variables that you derive from a value or collect from the user. For 
example, a chart could use a query that returns project overspends. If the project element in the 
query is a variable, you can let users select the project from a drop-down list. In Business 
Architect this would be configured via pinning – the query variable would be exposed on the 
chart's Inputs tab and pinned to the drop-down list. 

In any Queries pane, if you click on a query that uses a variable or parameter, it expands to 
show you what it requires to run (or be tested), for example: 
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Note: Query Builder's Test tab does similar when displaying such a query. 

Tip – Develop 'the parameter' and 'variable' versions of queries 

It can be useful to develop variants of the same query. For example, Find Self From 
Parameter and Find Self From Variable. 

Setting variables in Query Builder 
By default, Query Builder expects literal values, but you can change it to expect a variable. 

To set a variable, click the down arrow button at the relevant place, for example, 

 

and then click Variable: 

 

You can then type a name for the variable in the space provided (type over insert variable 
name): 

 

When Query Builder includes variables, its Test tab changes to let you supply suitable test 
data. 
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Query Builder can remember the variable settings. Use the cog icon illustrated in the following 
image. 

 

 

 

Note: If you have a query that uses multiple variables, ensure that your variables are 
uniquely and sensibly named. This is good practice and helps avoid clarity issues 
when using such queries within, for instance, Info panels. Good naming 
conventions are valuable throughout MooD. For example, if your meta model 
includes client and supplier organizations, don't have a variable just called 
organization. 
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Info panels 
Info panels are small tables that show information about elements. 

Note: MooD tends to recommend using matrices instead of Info panels. You have 
greater control over matrices meaning they can be better for Active Enterprise . 
However, Info panels are a quick way to add small tables to your models. 

Info panels always have a subject element, and show information derived from it such as 
related elements, field values, dependencies, measures, matrices and queries. Info panels can 
include one or more columns, and you can include a total for each column. For example, the 
following Info panel includes child elements of the subject element, and two columns showing 
values from those child elements. 

 

This next image shows an Info panel that includes two Smart Columns, and has the total 
enabled for the first column. 

 

When a model is displayed, the Home tab includes an Insert group. This has a Panels button. 
Use this to add Info panels. Click the buttons: 

• Top half to add a standard Info panel already pinned to the model's subject element 
(although you can change this). 

• Lower part to choose the type of Info panel to add, as shown here. 

 

See the next info box (page 83) for details on the other types of Info panel. 
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Note: If Business Architect is displayed in a small window, the ribbon can appear 
different. For example, as shown in the following image, there is a smaller version 
of the Panels button with the same functionality organized left right, instead of top 
bottom. 
 

 

When you place a standard Info panel onto a model, it flips so that you can set its content using 
the Information Shown setting (which displays a Select Content dialog box) as shown here: 

 

When an Info panel is selected on a model, the ribbon includes formatting options for that Info 
panel. These are under Panel, on the Settings tab. The Layout and Home tabs include 
general formatting commands. 

Additional types of Info panel 

In addition to the standard Info panel covered in this guide, two other types are available 
from the lower part of the Panels button: Add Elements Manually and Add Icon of 
Subject. Respectively these display: 

• A list of elements that you add manually: 

 

• The icon for the subject element that you can then add columns against to achieve 
effects like: 
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With this type, use the ribbon to add columns and configure the panel (this type of 
Info panel doesn't have a flip side). 

Adding an Info panel 

Task 7 To add an Info panel to a model: 

1. Open the model. 

2. On the Home tab, in the Insert group, click the top portion of the Panels button. 

 

When the pointer is over the model, it shows that a standard Info panel will be added 
when you next click. 

 

Note: If you click the lower portion of the Panels button, you can choose from the 
three types of Info panel. The upper part of the button defaults to the 
standard Info panel. See the info box that precedes this task for details on 
the other two types. 

3. Click where you want the Info panel to appear. 

The Info panel is added to the model (you can move it later). It opens on its flip side. 

 

4. Use the flip side to set the Info panel's content. 
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To help you: 

• On the Content tab, Subject of panel sets the subject element. By default, this is the 
model's subject element, but you can change this. 

• Information shown uses the Select Content dialog box to find and select what will 
be shown in the Info panel. For example, it could be one of the subject element's 
measures, the subject element itself, or a list of elements related to it. 

 

• Manage columns lets you add columns to the Info panel. These columns show 
information for each element included in the Info panel as a result of the Information 
shown setting. For example, Information shown might be a list of project elements, 
and you then add columns to show costs and revenue for each project. 

• Manage columns displays the Format Style dialog box, where you can add columns 
by means of the Add/Remove section shown in the following image. 
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• The Panel Settings and Column Settings sections in the Format Style dialog box 

give you considerable control over the general appearance of an Info panel (as does 

the ribbon (see step 6)). 

• Use the Results tab to see what the Information shown setting has found. This is 
what will appear in the Info panel. 

• If you set Information shown to a query that requires a parameter, use the Inputs 
tab to set that parameter. The Inputs tab adjusts itself as necessary and will often 
only include some basic refresh options. 

5. To flip the Info panel and reveal its content, click OK. 

Note: If the Flip button is red, your Info panel needs further configuration. In most 

cases, an exclamation icon  next to a tab or setting indicates where the 
issue is. 

6. Use the ribbon to format the Info panel. 

For example, under Panel, on the Settings tab: 

• In the Naming group, click Conventions to control how items are labeled. 

• In the Rows group, click Sort to manually sort the rows. 

Note: You can also do this on the Info panel's flip side. Use the Results tab. 

• In the Columns group, click Edit Columns to display the Format Style dialog box (as 
mentioned and illustrated in the preceding image, you can also access this from the 
flip side's Content tab). Use this to add or remove columns, change the column order, 
and add totals for individual columns. 

Note: You can also use the Format Style dialog box to format the Info panel, 
and then save that formatting as a style that can be applied to other Info 
panels. See Styles on page 117 for more details. 
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Smart Columns 
Smart Columns are part of MooD's aggregation technology along with the Aggregation matrix 
type. See Aggregation (page 20) in the Key Concepts section for an introduction. Aggregation 
matrices are not covered in this guide, but Smart Columns are a good introduction to 
aggregation in general. A video introducing aggregation is available within the Support Area at 
www.moodinternational.com and guides are available covering Aggregation Designer, Fact 
Builder and Aggregation Performance. 

A Smart Column performs a calculation on elements and obtains the result. For example, you 
might add up the total cost of all projects, or you might calculate the margin between revenue 
and expenditure. You can use Smart Columns in many places. For example: 

• As columns in Info panels and Data Sheet matrices. 

• As the basis for conditional formatting. 

• To provide labels (aggregations can output strings). 

The following image demonstrates the first example usage. It shows an Info panel with two 
Smart Columns, one showing a calculation, and one showing how each element compares 
against a threshold. 

 

Smart Columns are reusable items that can be organized into groups. Hence, in the Explorer 
Tree, they are listed under Libraries: 

When you click a Smart Column, and then click Open (beside the New button or on the Smart 
Column's right-click shortcut menu), it opens that Smart Column's definition as a tab in the 
workspace. 

Note: If you are looking at a group that does not include any Smart Columns, you can 
click New to create one. 

The tab includes several secondary tabs that define the Smart Column. The Designer tab is 
the one you will primarily use. It includes a visualization of the Smart Column, and a test area. 
Both are shown here: 

http://www.moodinternational.com/
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Smart Columns start with a source query. This finds the elements to be included. You then 
apply a single fact, and obtain a column of results complete with a total for that fact. A fact is a 
calculation (the result of an expression). Facts are the principal purpose of Smart Columns, as 
they are calculations that you can access and use elsewhere. The Fact Builder dialog box lets 
you build the expression that constitutes your fact. As shown in the preceding image, this is 
accessed from the Edit link in the middle of the Designer tab's visualization of the Smart 
Column. 

Starting from the source query, you can add levels. Levels are Find blocks that drill up and 
down from the source query. Levels let you: 

• Include other groupings of elements and obtain a total across those groupings. For 
example, find the parent elements of the source query so that the fact can be applied 
across that grouping and a total obtained. You include and exclude levels to specify the 
content you want (excluded levels appear dimmed). 

• Find repository content related to the elements found by the source query, and then use 
that content within your fact to obtain the result that you want from your Smart Column. 
For example, find measures for different months, and then include them within a 
Threshold fact to determine and display a trend. 

The sections: Creating a Smart Column (page 89), The Smart Column's visualization on the 
Designer tab (page 94), and The Fact Builder dialog box (page 94), cover all of this in more 
detail. 

Once you have defined a Smart Column, you can: 
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• Include it as a column in an Info panel or Data Sheet matrix. For the elements (rows) in 
both, the result of the Smart Column's fact for those elements will be shown. This is 
dependent on the elements concerned being included in the Smart Column's source 
query, or in one of its levels. If the Info panel or matrix includes an element outside the 
Smart Column's scope, its cell will be empty. 

• Place it directly onto models. This gives you a single column table, like the one shown 
in the Designer tab's test area. 

• Use it in other areas, including Free Form matrices, various graph panels, and as the 
basis for conditional formatting. For example, you can use a Smart Column with a 
Threshold fact to conditionally colour data series in charts. 

The Using Smart Columns section (page 99) covers this in more detail. 

Creating a Smart Column 
The following task illustrates how to add a basic Smart Column, and then introduces some of 
the additional design features available. 

Task 8 To create a Smart Column: 

1. In the Explorer Tree, under Libraries, click the  button next to the Smart Column 
group that you want to add the new Smart Column to. 

This selects the group, and displays its Smart Columns pane. 

2. In the Smart Columns pane, click New. 

A Smart Column tab opens in the workspace. 

 

All new Smart Columns are initially named Smart Column.  

3. Click in the Title box and give the Smart Column a meaningful name. 

It is also good practice to give a full description in the Summary box. 

4. Click the Designer tab. 
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This has a structural visualization of the Smart Column, and below that, an area where 
you can execute the Smart Column to see it populated with data from your repository.  

Note: This task goes on to introduce key features of this visualization. However, 
see The Smart Column's visualization on the Designer tab on page 94 for 
a more complete overview. 

5. Configure the Smart Column. 

As a minimum, you need to add a source query, and then add a fact. To help you: 

• Smart Columns start from a source query. This finds the elements to be included in 
the Smart Column. 

Click Source Query to go to the Source Query tab. This lets you define a query, 
and is the same as other queries in Business Architect. 

 

See Queries on page 74 for details on using the Source Query tab. 

• Smart Columns have one fact. This fact defines a calculation on the content of the 
elements found by the source query. 

In the centre of the Designer tab's visualization, click Add (or Edit if the Smart 
Column has a fact) to display the Fact Builder dialog box. 
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See the Fact Builder dialog box section (page 94) for details. 

• Once you have a fact in the centre of the Designer tab's visualization, you can control 
how its results are displayed in the table when it is generated. For example, as can be 
seen in the following image, you can control alignment and wrapping. 

 

Tip – Aggregation matrix: Cumulative and Display Value As 

Facts in Aggregation matrices include two additional formatting settings: 
Cumulative and Display Value As. 

 

Cumulative lets you show totals across rows or columns (including across totals 
if required). Display Value As lets you show results as a percentage of the total. 
If you require either of these, consider using an Aggregation matrix instead of a 
Smart Column. 

• Once you have a source query and fact, you can use the ribbon to test the Smart 
Column. On the Home tab, in the Matrix group, click Execute. 

At this point, you should have a functioning Smart Column that you can use in a range 
of places, including Queries or Data Sheet matrices. The info box that follows includes 
some additional features you may want to use. 
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Smart Column Designer tab - additional features 

You can click add a level to add a Find block that drills up and down from the source 
query. This can: 

• Find and make available content that you want to utilize within your fact, 
such as measure content. 

• Bring further element groupings into the Smart Column that then have the 
fact applied and rows added. For example: 

 

Again, this functions like any query in Business Architect, except that the starting 
point is set to the Smart Column's source query (the source query is effectively the 
first level and cannot be changed). 

You can add multiple levels: 

• Each level starts from the preceding level's elements. 

• You can click each level (including the source query) and add a where 
condition to further qualify that level. 

• Again, the filter icon indicates when a where condition is in effect. 

In addition, as shown in the following image, you can include and exclude levels 
from the Smart Column. Excluded levels appear dimmed. 
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Each time you click Execute, the table in the test area is updated to reflect the 
included content. 

You can also click a level's Source Query link and add a where condition to further 
qualify the results of the source query. For example: 

 

When a where condition is in effect, the Designer tab includes the filter icon against 
the item affected, for example: 

 

 

Finally, as shown next, click the cog icon to get a menu that lets you manage levels. 
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The Smart Column's visualization on the Designer tab 
This section has reference material that explains and summarizes the visualization used on a 
Smart Column's Designer tab. It duplicates much of the information covered in the preceding 
task, but provides an alternative approach that some readers may prefer. 

Figure 1. The Smart Column's Designer Visualization 

  

 

1 Source Query. Click this to display the Source Query tab, and then set or edit the 
query that finds the elements that the Smart Column will operate on. If the source 
query is included (4) in the Levels area (3), the elements returned by the source query 
will be included as rows in the Smart Column, and have the fact applied. 

2 Fact. The single fact (aggregation) that the Smart Column will perform. Click Edit to 
display the Fact Builder dialog box. The fact can utilize content from the source query 
and levels. 

3 Levels. Each level is a Find block that drills up and down from the source query (if it is 
the first level), or from the preceding level. Levels give you groupings of elements to 
include in the Smart Column (included levels produce rows, excluded (dimmed) levels 
do not), and provide content that you can access and use in facts. For example, a 
level might find the parent elements of the source query elements, or levels might be 
used to find measures for comparison within a fact. 

4 Included Content. The source query and levels can be included or excluded. When 
included, rows are added to the Smart Column. Excluded content appears dimmed. 

Note: In Smart Columns, the level hierarchy is flattened into a single column of 
rows in the table produced in the test area below the visualization. This 
is because the primary purpose of Smart Columns is to give you access 
to the result of a fact, and not to produce a table that you can include on 
a model. 

5 Filter. You can filter the results of a fact. 

 

Copy and paste facts 

A recent addition (Build 85) is the ability to copy a fact and paste it as a new fact. 
Aggregation Designer now includes Copy and Paste options, shown here: 
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Paste is only shown when a fact has been copied. The copied fact is held in memory until 
another fact is copied i.e. the buffer holds one fact at a time. Hence, you can open two 
aggregations and copy a fact from one to the other. You cannot paste facts into notepad or 
similar, and you cannot copy fragments of facts. Any conditional formatting in a fact is not 
included in the copy. 

In Aggregation matrices, when you paste a fact, it is added at the bottom. 

As Smart Columns only have one fact, if you paste a fact into a Smart Column, it overwrites 
any existing fact. Because of this, you get a warning when pasting into Smart Columns. 

The Fact Builder dialog box 
A Smart Column must have one fact. This is the Smart Column's calculation. On the Smart 
Column's Designer tab, click Add (or Edit) to open the Fact Builder dialog box. 

 

Use the Fact Builder dialog box to create your Smart Column's fact. For example: 

 

As you build an expression, the Fact Builder dialog box only offers valid options. For example, 
it won't let you include a closing parenthesis if there is nothing to close. In the following image, 
you can see a Simple SUM fact being constructed: 
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At any time, you can return to the Smart Column's Designer tab to test your fact, and see if it 
gives you the expected results. 

The Fact Builder dialog box lets you construct five types of fact: 

• Simple 

 

A single expression based fact. An expression is a calculation that produces a numeric 
or date result. For example, revenue minus cost produces a result that you could call 
profit. 

There are five types of Simple expression. Click SUM to choose a type (the Fact 
Builder dialog box always defaults to SUM). 

 

Type Returns 

SUM The sum of a number of values. This sum includes the basic 
arithmetical operators +, -, * and /. You can also include parenthesis to 
enforce precedence. 

SUM of Pick states – Counts 

If you do a SUM on a Pick list state, it gives you a count of that state. 
For example: 
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When you select a Pick list as a source value, you choose the Pick 
list state to be counted, as shown here: 

 
 

MIN The minimum value in the expression's results. For example, the project 
with the lowest revenue. 

MAX The maximum value in the expression's results. 

AVG The arithmetic mean (average) of the values in the expression's results. 
For example, average revenue across all projects. 

COUNT The number of source elements in the expression (as grouped by the 
Smart Column's levels). For example, the number of projects currently 
active. 

 

Sorting and the Top N property 

When a fact is configured and shown in the Designer tab, you can control how it is 
sorted. The Top N property (shown in the following image) can be set to a number or 
a variable, and is useful if you only want, for instance, to show the best (or worst) 
performing items. 

 

 

• Embedded 

 

Incorporates Simple facts within a larger expression, and gives the result. For example, 
you could multiply the result of a SUM by the result of a COUNT, or multiply a SUM by a 
variable. 

You build each component Simple fact within the Embedded fact itself. 

• Threshold 
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Compares the result of a Simple fact expression against a Threshold, and returns the 
corresponding Pick state. This is illustrated in the following image where a Threshold 
fact is used to compare a SUM expression (Revenue) against a Threshold (Risk) to 
display one of four Pick states against each element in the Smart Column. 

 

• Free Form Threshold 

 

Calculates a Pick list state from the value of an expression. This fact type was 
introduced in Build 63. It is documented in the Changes Between Build 54 and 69 guide. 

• Aggregated Pick State 

 

Return the minimum (MIN) or maximum (MAX) Pick list state for a Pick list. This can be 
used to show the extreme cases to be found within a group of elements. For example, if 
looking at risk within a group of projects, you could quickly see the highest rated risk 
currently active within that grouping. 

 

When you set Fact Type to Aggregated Pick State, you can choose between MIN and 
MAX, and then select a Pick list, as shown here: 
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Note: The MIN and MAX of a Pick list is determined by the order of states within 
it. Hence, you should ensure that your Pick lists are ordered from the MIN 
(first state) to the MAX (last state), and not some random collection of 
states in no particular order. 

The Fact Builder dialog box and Aggregation matrices  

The Fact Builder dialog box is used in two places: Smart Columns and Aggregation matrices. 
They are derived from the same technology, and the Designer tabs for both are very similar. 
Aggregation matrices let you include multiple facts as columns in a table, and include a total 
for each column across multiple dimensions and levels. Aggregation matrices are not 
covered in this Getting Started Guide. 

Using Smart Columns 
Although you can place Smart Columns directly onto models to get a single column table like 
the one shown in the Designer tab's test area, Smart Columns are principally intended for 
inclusion: 

• As a source of content for various graph panels. If a panel supports the use of Smart 
Columns, the panel's flip side will let you select one. 

• As the basis for conditional formatting. Many places can use Smart Columns to 
determine their conditional formatting. For example, this next image illustrates this in a 
Data Sheet matrix. On the Conditional Formatting dialog box, when you click Show 
Pick Lists from related elements you get a Select Content dialog box where you can 
select the Smart Column. 
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And in a chart, when Conditional is selected on the ribbon, a Colour field is added to 
the Select Content dialog box. Set this to a Smart Column. 

 

 

• As columns in Info panels. 

The Info panel's Subject Element and Information Shown settings return elements 
(rows) that the Smart Column will then be executed for. For example, Information 
Shown might return the children of the subject element, and the Smart Column then 
shows some calculation for those child elements, as shown here: 
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Note: You cannot set an Info panel's Information Shown setting to a Smart 
Column. Smart Columns can only be added as additional columns. 

See Info panels on page 82 for details on creating and using Info panels in Business 
Architect. 

• As columns in Data Sheet (or Free Form) matrices. 

When you add columns to a Data Sheet matrix, the Select Content dialog box lets you 
choose a Smart Column. You can include multiple Smart Columns, for example, two of 
the columns shown in the following image are Smart Columns: 

 

The Smart Column's fact is executed and displayed for each row included in the matrix. 

Using a Smart Column as Row data in a Data Sheet matrix 

In a Data Sheet matrix, on its Designer tab, if you select Row data's Use a 
Dependency setting, and then click edit, you can select a Smart Column. This uses 
the Smart Column's query to find the rows, and adds the Smart Column as the first 
column in the matrix. 

You can add additional columns as required, and change the column order. 
However, you cannot remove the matrix column that is added for the Smart Column. 

See Matrices on page 102 for details on creating and using matrices in Business 
Architect. 

 

For values to appear in an Info panel or matrix, the elements included as rows must also be 
included in the Smart Column. If not, the corresponding cell will be blank. This can affect how 
you design your Smart Column. For example, if a Smart Column's source query only includes 
the children of a project element, the Smart Column will not calculate its fact for any 
descendants of those children. Hence, an Info panel or matrix that includes all descendant 
project elements will only show Smart Column results for children of the project element. To 
include results for all, you would need to add a level to the Smart Column, or change its source 
query to find all descendant elements. 

Tip - Smart Column totals 

Both Info panels and Data Sheet matrices can include a total for any Smart Column 
included. By default, totals are not included. To include a total: 

• For an Info panel, when you add a column, make sure Total is set to yes: 
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• For a Data Sheet matrix, ensure Show Total on the Edit Columns tab is set to yes: 

 

 

 

Matrices 
A matrix is a table used to display information. See Matrix in the Key concepts section (page 
19) for a general discussion on matrices and the types available. This section describes how to 
find, create, and use matrices in Business Architect. 

Matrices are reusable items. Hence, in the Explorer Tree, they are listed under Libraries. 

If you click a matrix, and then click Open, it opens that matrix's definition in the workspace. This 
workspace is referred to as Matrix Designer, and is shown in the following image. 
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Matrix Designer has several tabs. These change depending on the type of matrix. However, the 
General tab always includes a Tasks section that outlines the steps required to create a 
working matrix. 

On the Home tab, the Matrix group includes the Execute command. Use this to generate the 
matrix and see the result in the lower part of each tab. The Creating a matrix task next covers 
all of this in more detail. 

Note: This guide assumes you are using an established repository complete with 
matrices, and can therefore easily access Matrix Designer. If you are looking at a 
group that does not include any matrices, click New to start adding one. 

 
Before Matrix Designer appears for the new matrix, you must select an owner 
element and a matrix type. Again, this is covered in the Creating a matrix task. 

Once you have defined a matrix, you can use it on a model. Once a matrix is on a model, you 
can set its properties for that instance of its use. When the matrix is selected, the ribbon 
includes tabs for it. You can also flip the matrix and set further properties. 

Creating a matrix 
The following task adds a simple Data Sheet type matrix. 

Task 9 To create a matrix: 

1. In the Explorer Tree, under Libraries, click the  button next to the matrix group that 
you want to add the new matrix to. For example: 

 

This displays the group's Matrix pane. 

2. In the Matrix pane, click New. 

A drop-down prompts for the owning element. In MooD, matrices are owned by 
elements. Consider using a #typeName or #MatrixContainer element. See Tip – Benefit 
of # root elements for why (page 62). 

Note: You can change the owning element later. In the Matrix pane, right click a 
matrix and then click Move To. There is also a Copy To command. 

3. Click the owning element. 

This displays the Matrix Type dialog box. 
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Alternative... 

You can also get to this point by selecting the owner element, and then choosing 

Examine . As shown in the following image, the element's Examine pane includes 
a Matrices category with a New button. 

 

 

4. Click a matrix type, and then click OK. 

Note: This example continues with the Data Sheet matrix type. The Matrix Type 
dialog box explains each type, as does the More on matrices section within 
Key concepts (page 19). 

Matrix Designer opens in the workspace. The General tab includes the subject element, 
and the chosen matrix type is used as the default name. 
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5. In the Title box, give the matrix a descriptive name. 

6. Configure the matrix. 

The following advice and guidance should help you: 

• The General tab's Tasks area lists the steps required to get a useable matrix. 

 

Typically, you define a query to return your rows, and then pick the columns to 
include for each row returned by your query. Use the buttons and links to go to the 
correct place to complete each task. 

 

The Row data settings – Edit Row Query and Use a Dependency 

  

The Edit Row Query and Use a Dependency settings specify whether the matrix 
will get its rows from a query, or from a dependency selected by means of a 
Select Content dialog box. Edit Row Query takes you to the Row Query tab, 
where you can construct and test a query. If you opt for Use a Dependency, your 
selection will appear next to the highlighted Use a Dependency button, as shown 
here: 

 

The reset link lets you reset the row data source to a query chosen from a 
selection of basic queries listed in a Select Query dialog box: 
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The selected query can then be viewed and edited on the Row Query tab, and if 
Use a Dependency was set, it is cleared. 

 

• The Row Query tab lets you define a query to find the rows for your matrix. 

 

The right-hand section lists various categories of building block that you can use in a 
query. 

Consider developing a named query that can be reused elsewhere. However, if it is 
vital to ensure that the query is not changed, develop it in place. 

See Queries on page 74 for an introduction to creating queries in Business Architect. 
This includes information that will help you understand and use this tab. 

Starting from the matrix subject 

One possible starting point is the matrix subject. 
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Initially this is the owning element. However, when you place the matrix on a 
model, it takes the model's element as its starting point. This means you can 
develop one matrix, and then use it in many places. See Using a matrix on a 
model on page 108 for information on placing matrices on models and using this 
feature. 

 

• The Edit Columns tab lets you select content that will appear as columns in your 
matrix. For example, in the following image there are three columns (two number 
fields and a Smart Column). 

 

Totals 

By default, the columns in a Data Sheet matrix are not totalled. To add a total, set 
the column's Show Total property (click the column to expand its properties). 

 

• The Matrix, Row, Col and Cell tabs let you set general properties for each of these 
areas. 

• If your matrix requires a variable in its query, enter it on the Variables tab. 
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• Use the ribbon to test your matrix. On the Home tab, in the Matrix group, click 
Execute. 

 

The lower part of the workspace displays the generated matrix. Use this to 
interactively develop your matrix before placing it on a model. 

Once you have defined a matrix, you can use it on a model. 

Using a matrix on a model 
You drag and drop matrices onto models. 

 

Typically, when you drop a matrix, you get the following dialog box with two of the three options 
enabled: 

 

You can add a working version of the matrix, or a thumbnail that opens the matrix. 

Note: The working version is not a separate copy. Any changes you make to the matrix 
in Matrix Designer will affect all placements of that matrix. However, any visual 
changes you make to the matrix on the model are specific to that model. 



MooD 16 Getting Started Guide 
 

 109 

Tip – Making a matrix transparent 

You can format a matrix so that it only includes its data and has no dividing lines. This can 
be useful if you want the matrix to overlay a corporate background. In Matrix Designer, on 
the Matrix tab, the Matrix group of settings lets you set Colours to several different 
Transparent colour schemes. 

 

As shown in the next image, if the matrix starting point is set to the matrix subject (see the 
Starting from the matrix subject info box on page 106), the third option in the Add Matrix dialog 
box is enabled and the model's element becomes the matrix subject. 

 

 

 

Adding matrices using symbol fills and Model Masters 

You can also use an element's symbol, or it’s Model Master, to include a matrix on a model. 

When you include an element on a model, it is represented by its symbol. You can format 
symbols, including their fill. Often this is a colour, but it can be one of the element's 
matrices. 

 

You can also include matrices in Model Masters. Any element using that Model Master will 
get the matrix. See Model Masters on page 123 for details. 
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Graph panels (gauges, charts and maps) 
Graph panel is the general term for the assorted ways you can visually present information 
from your repository. They are grouped into: 

• Gauges. Assorted dials, sliders, thermometers and traffic lights. 

• Graphs and Charts. A variety of graphs and charts such as Column, Pie and Bar, and 
the more specialist Radial, Radar, Network and Clock Face. 

• Maps. Assorted map formats and controls, such as the World Map or Open Street Map 
panels. 

You should be able to find a graph panel that suits your needs. All graph panels are added in 
the same general way. You place them on a model, specify where it gets its content from (for 
example, a query or an Aggregation matrix), and then format it to get the look and feel you 
require. In general, you use the flip side to set the content and the ribbon to set the formatting. 

When a model is displayed, the Home tab includes an Insert group. This has a Graphs 
command. 

 

Click this to see a gallery of available visualizations that you can add to the model. 

Once you have dropped a graph panel onto a model, you can flip it and set its contents, and 
use the Panel group of tabs on the ribbon to format it. These tabs vary depending on the graph 
panel type. 

Adding a graph panel 

Task 10 To add a graph panel to a model: 

1. Open the model. 

2. On the Home tab, in the Insert group, click Graphs. 

A gallery of graph panels is displayed. For example, here is part of the gallery: 

 

3. Click a graph panel. 

The pointer shows the type of graph panel. 
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4. Click where you want the graph panel to appear. 

The graph panel is added to the model, and opens on its flip side. 

5. Use the flip side to set the graph panel's content. 

Column chart example 

The flip side varies between graph panels, although they all share common 
characteristics. The points here are for a Column chart, but should help you with any 
graph panel. 

 

To help you configure a Column chart: 

• As you use a flip side, the  icon on a tab or next to a setting suggests what 
you should pay attention to. 

• On the Content tab, use Subject of panel to set the subject element. 

• Information shown displays the Select Content dialog box for the subject 
element. Use this to find and select what will be shown on the chart. For 
example, if the subject element is a project element, Information shown 
could be its children (sub projects). Often you will set this to a query. 

• Use the Results tab to see what the Information shown setting has found. 
These will be the columns in the chart. You can reorder the items, and hence 
the columns. 

• If you set Information shown to a query that starts from the parameter or 
uses variables, these will be exposed on the Inputs tab for pinning. The 
Inputs tab adjusts itself as necessary and may only include some basic 
refresh options. 
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• Select fields displays another Select Content dialog box. Use this to find 
and select what will be plotted for each item on the X axis. For example, this 
could be cost, meaning that the chart will plot the cost for each project. 

• You can select more than one field, meaning that a data series will be 
plotted for each field. For example, you could have estimated and actual 
cost for each project. 

• If you set Information shown to an Aggregation matrix, Select fields is 
removed from the dialog box. Instead you get the Assign setting which 
defaults to Aggregation (X – rows, Y – 1st column…) meaning that the 
matrix rows are plotted on the X axis and the columns (facts) are plotted as 
series on the Y axis. 

• Show data table shows you a table containing the data found as a result of 
your Information shown and Select fields (or Assign) settings. This lets 
you check the data that will be plotted on the chart. 

 

6. To flip the graph panel and reveal its content, click OK. 

Note: If the Flip button is red, your graph panel needs further configuration. In 

most cases, an exclamation icon  next to a tab or setting indicates 
where the issue is. 

7. Use the Panel group of tabs on the ribbon to format the graph panel. 

As you change settings, the graph panel changes to show the effect. 

8. If the graph panel is going to be used on the web, preview its functionality in Active 
Enterprise. Use the Web tab on the ribbon. It includes a Preview command. See Active 
Enterprise on page 147 for details. 

The General chart type 
There are many graph panels. The most flexible is the General chart. It is highly configurable 
as you get direct access to its underlying settings. It defaults to a column chart, but can be 
changed to many other formats including pie and bar. One particular reason for using the 
General chart is that each data series can be plotted in a different format, for example: 

 

The downside of the General Chart is its configuration is less obvious due to working at a lower 
level. Best practice is to use the dedicated graph panels first and only use the General chart 
where necessary. See the General Chart User Guide for full details. 
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Action panels (making models for the web) 
Action panel is the general term for the many controls that allow you to develop dynamic web 
solutions using MooD Active Enterprise. They are grouped into the following categories: 

• Controls. Includes many general purpose controls such as drop-down selection, 
calendar and tick box controls. 

• Editing Elements. Includes, for example, a control that lets users edit the contents of a 
specified field. 

• Navigation. Includes, for example, a control that lets users choose, and then go to, a 
model. 

• Security. Includes, for example, controls to create users and send password reminders. 

• Web Page. Page management controls such as a refresh timer. 

You should be able to find action panels that suit your solution requirements. 

All action panels are added in the same general way. You place them on a model that you 
intend to publish using Active Enterprise, and then configure and format them to get the look, 
feel and interaction you require. 

When a model is displayed, the Home tab includes an Insert group. This has an Actions 
command. 

 

Click this to see a gallery of action panels that you can add to the model. 

Once an action panel is on a model, you can flip it and configure its content or behaviour, and 
use the Panel group of tabs on the ribbon to format it. The tabs vary depending on the action 
panel type. 

Here is an example scenario for action panels. You want to add a button that generates a 
report on the primary element in a Model Master (basically produce a report on what the user is 
looking at). You have a Documents synchronizer that generates the report using a variable for 
the subject element. To do this you: 

• Add the Button action panel to the Model Master, flip it, and set it to Execute a 
synchronization (you get to choose from a variety of repository, navigation and generic 
actions). 

• Because the Execute a synchronization action is selected, the button's Content tab 
now includes a field that lets you choose the actual synchronizer. 

Once you select the Documents synchronizer, because it includes a variable, the 
button's Inputs tab gets a field (and pin) for that variable. Pin this variable to the 
Primary Element symbol on the Model Master. Hence the report will be generated for 
the element currently being viewed. 

This next task illustrates much of what has just been described. 
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Adding an action panel 

Task 11 To add an action panel to a model: 

1. Open the model. 

2. On the Home tab, in the Insert group, click Actions. 

A gallery of action panels is displayed. For example, here is part of the gallery: 

 

3. Click an action panel. 

The pointer shows the type of action panel. 

 

 

4. Click where you want the action panel to appear. 

The action panel is added to the model, and opens on its flip side. 

5. Use the flip side to configure the action panel. 

Button example 

The flip side varies between action panels. As an example, here is the flip side of the 
Button action panel: 
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A Button is often used to refresh another panel. To do this, you pin the blue pin on 
that panel's Inputs tab to the Button. The following image shows an Info panel blue 
pinned to the Button action panel. 

 

You can use the Also or alternatively setting on the Content tab to display the 
Select Action dialog box (shown next) from which you can select the action 
required. 

 

If you select an action that requires further configuration, the flip side adjusts and 

points you in the right direction (the  icon). For example, as shown in the following 
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image, if you configure a Button to Execute a synchronization, the Content tab 
changes to include synchronization settings. 

 

 

6. To flip the action panel into place, click OK (or press F9). 

Note: If the Flip button is red, the action panel needs further configuration. In 

most cases, an exclamation icon  next to a tab or setting indicates 
where the issue is. 

7. Use the Panel group of tabs on the ribbon to format the action panel. 

As you change settings, the action panel changes to show the effect. The Layout tab 
also includes some formatting commands. 

8. Test the action panel by previewing its functionality in Active Enterprise. Use the Web 
tab on the ribbon. It includes a Preview command. See Active Enterprise on page 147 
for details. 
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Styles 
Styles let you apply formatting consistently throughout a repository. For example, you can have 
a style that makes all Info panels use the same colour scheme. 

Styles are reusable items. Hence, in the Explorer Tree, they are listed under Libraries. 

In the Styles pane, if you right-click a style and then click Format Style, it displays the Format 
Style dialog box shown in the following image. Within this dialog box, the style's current 
settings appear highlighted. 
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Tip 

It can be useful to know where styles are used, and whether something has a style applied. 

• To see a list of elements and models where a style is used, in the Styles pane, right-
click a style, and then click Show Where Used. 

 

You can then open a model and see how the style looks in use. 

• To find out if something on a model is formatted with a style, you can: 

• Click it, and then, on the Home tab, in the Drawing group, click Style Gallery. If a 
style is applied, it is highlighted in the gallery. 

• If the item is not an element, for example, an Info panel, get its tooltip to appear. If a 
style is applied, it is included. 

Creating a style 
You can add a style in two ways: 

• Create a new style, and then format it. This method is covered in the next task. 

• Create a style from something already formatted. This method is useful if you have 
formatted something and then decide that you would like to save that formatting for use 
elsewhere. The two ways of doing this are covered after the task. 

Task 12 To create and format a new style: 

1. In the Explorer Tree, under Libraries, click the  button next to the styles group that 
you want to add the new style to. 
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This selects the style group, and displays its Styles pane. 

2. In the Styles pane, click New. 

This displays the list shown here: 

 

3. Do one of the following: 

• If you want to create a format for shapes, click Shape Style. 

• If you want to create a format for lines, click Line Style. 

Either choice adds a style with the name New style. It has default, basic formatting. 

4. Rename the style. 

5. Right-click the renamed style, and then click Format Style. 

The Format Style dialog box is displayed. 

6. Format the style as required, and then click OK. 

The representation of the style changes to reflect the applied formatting. You can return 
and change the formatting at any time. If you change a style that is already in use, those 
occurrences are updated to reflect the modified style. 
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Create a style from an existing item 

If you like the way something is formatted, you can create a style from it. You can do this in 
several ways: 

• Click the item to select it, and then, in the Styles pane, click New, and then click 
Style from selection. 

• Right-click the item, and then click Format Style. This displays a Format Style 
dialog box with a Save button. Click Save, and then click To Style Gallery. 

 

This displays the Save Style dialog box. Use this to save the formatting as a new 
style, or to overwrite an existing style. 

Note: If you overwrite an existing style, all occurrences of that style are 
updated to reflect the new formatting. Before doing this, you may want to 
right-click a style and then click Show Where Used to see how many 
models will be affected. 

• Select the item, and then, on the ribbon, click Style Gallery, and then click Create 
Style From The Selected Symbol.  

 

This displays the Save Style dialog box. Use this to save the formatting as a named 
style. 
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Applying, updating and deleting styles 
You can apply styles in the following ways: 

• Use the Explorer Tree to open a Styles pane, and then drag a style onto the item you 
want to apply it to. Business Architect tells you that the style will be applied when 
dropped, as shown here: 

 

Note: If you drop a style directly onto the model itself, a text box is created with 
that style. 

• Select the item that you want to apply a style to, and then, on the ribbon, use the Style 
Gallery button to select and apply a style. 

 

The main benefit of styles is that when you update one, the change is applied to everything that 
has that style. This can be useful if, for example, you decide that a rectangle would be better 
than a circle, or that a line should be thicker. 

To update a style: 

• In the Explorer Tree, under Libraries, open a Styles pane and find the style. Right-click 
the style, and then click Format Style. Use the Format Style dialog box to change the 
style. When you click OK, everything with that style is updated with the changes. To see 
a list of places affected, right-click the style, and then click Show Where Used. 

• Find an instance of the style in a model, update it, and then overwrite the style. See the 
Create a style from an existing item box on page 120 for more details. 

Tip 

When you delete a style, it is removed from the repository, and items with that style lose their 
association. However, they do not lose the style's formatting. 

This means that deleting a style is not a quick way to revert everything tagged with that style 
to its default formatting. To do this, on a model, select a symbol with the style, and then, on 
the ribbon, click Style Gallery, and then click Revert to Default Style. Next, use the same 
menu's Create Style From the Selected Symbol command to overwrite the original style 
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with the reverted formatting. This puts everything tagged with that style back to the default 
formatting. You can then delete the style. 

Difference between styles and formatting 
On the Home tab, the Drawing and Font groups include many formatting options. You can 
apply formatting to individual items. You do not have to use styles. You can also apply a style 
to get some default formatting, and then change some of it. Provided you do not update the 
style based on that item, those changes are unique. 

To find out if something on a model is formatted with a style, click the item to select it, and then, 
on the ribbon, click Style Gallery. If a style is applied, it is highlighted. 

See Selecting, formatting and arranging items on a model on page 40 for general information 
on applying formatting without using styles. 

  



MooD 16 Getting Started Guide 
 

 123 

Style Sheets  

Style Sheets are a brand-new way of styling your repository, with a slick UI and an intuitive 
editor, this new feature provides ease of use when creating new Styles. 

To access Style Sheets in a repository, first go to Styles and there you will see a new tab option 
for ‘Style Sheets’. New Style Sheets can be created by clicking ‘New’. 

 

A Default Style Sheet is already present in the software. This Style Sheet cannot be deleted, 
moved around or renamed. When you are logged in as an Administrator and delete a Style 
Sheet, all panels associated with that Style Sheet revert to the Default Style Sheet. 

 

Click on your chosen Style Sheet to make the easy-to-use Style Sheet Editor appear. There are 
two tabs: the first Overview tab allows you to change setting and styles common in many 
panels, such as Font, and Background Colour. 
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The second tab, Panels, provides a bigger customisable section, giving various options for 
separate panels. 
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Another useful feature is the Interactive Preview. When customising panels and other parts of 
the repository, the preview will automatically show you the changes made in the editor and how 
it will appear in the repository. 

 

There is also the option to ‘Bulk Apply’ Style Sheets from the Default Style Sheet. This can be 
found in the Styles tab. By right-clicking the Style Sheet you wish to Bulk Apply, an option will 
appear allowing you to Bulk Apply. Bulk Apply will apply the selected Style Sheet to every 
model in the Repository. 

 

When on a model, there is the ability to apply a Style Sheet to an individual panel. Simply 
select the panel, click on the drop-down box and select the Style Sheet you wish to apply. 
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Style Sheets can also be used in Deployment packs. Simply click ‘Add…’ to search for style 
sheets, which will then show you the available Style Sheets which can be deployed and used in 
another repository. 
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Model Masters 
Model Masters let you apply templates to an element's model and thereby ensure consistent 
appearance and functionality. For example, a Model Master might include standard navigation 
controls and a corporate logo. 

Model Masters save development time. Instead of repeatedly creating models for a theme's 
elements, you can create and apply one Model Master. Model Masters also save time when 
maintaining solutions. Changes to a Model Master affect all instances of its use. 

A Model Master can include anything that can appear on a normal model. You can apply Model 
Masters to elements and relationships. You can also select the Model Master to use when an 
element is accessed from an Info panel, matrix, or selected types of graph panel. This 
overrides any Model Master setting that the element itself has. 

Model Masters can be applied singly or in layers – known as hierarchical Model Masters. See 
Hierarchical Model Masters on page 131 for more information on this feature. 

Model Masters are reusable items. Hence, in the Explorer Tree, they are listed under Libraries. 
To see hierarchical Model Masters you need to use Tree view. The Thumbnail views let you 
see individual Model Masters. 

If you double-click a Model Master (or right-click, and then click Look Inside), it displays the 
Model Master's own model in the workspace, as shown in the following image. 

 

The Model Master's model shows you what features and formatting it will impose when it is 
applied to an element. You construct and format this model like any other model. By default, it 
includes a primary symbol. This represents the element that the Model Master will be applied 
to. 

To help you see what effect the Model Master will have, you can drag elements into the Test 
using box along the top of the model. That element becomes the primary symbol for the 
purposes of testing. 

When a model is displayed, the Model tab includes the Model Master group, as shown in the 
following image. This includes a gallery of Model Masters that you can apply. 
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If the model does not have a Model Master, the Edit Master button is disabled (a quick way to 
open the Model Master used by a model is to click Edit Master). 

Note: If you don't have any Model Masters, this gallery won't appear on the ribbon. 
Instead, the Model Master group will include an Apply Master button. This opens 
the Model Masters pane. You can then create a Model Master (as covered in the 
next task). 

Creating a Model Master 
You can create a Model Master in two ways: 

• Create a new Model Master, and then format it. This method is covered in the next task. 

• Duplicate an existing Model Master, and then modify it. 

Task 13 To create and format a new Model Master: 

1. In the Explorer Tree, under Libraries, click the  button next to the Model Masters 
group that you want to add the new Model Master to. 

 

This selects the Model Master group, and displays its Model Masters pane. 

2. In the Model Masters pane, click New. 

This adds a Model Master called New Model Master, and selects its name. 
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3. Give the Model Master a descriptive name. 

4. Right-click the renamed Model Master, and then click Look Inside. 

The Model Master's model opens in the workspace. In the images here, the Model 
Master is called Outcome. 

 

Note: Model Masters are typically targeted at a type of element (known as the 
primary symbol). In most cases, it is useful to develop a Model Master 
with a suitable element in place. For example, if you are going to include 
and configure an Info panel, you need an element in place to see the effect 
of the Model Master. This example continues on this assumption. 

5. Drag a suitable element into the Test using box. 

The primary symbol is populated with this element, and the Test button toggles to Stop 
Testing (you can continue in either mode). 

 

 

6. Configure the Model Master. 

To help you: 
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• You can add Info panels, matrices, graph panels, action panels, and anything else 
that you could put on a standard model. 

• You can pin content. 

• You can format everything, and that formatting will be used whenever the Model 
Master is used with an element. 

• If the target element has its own model, remember that the end result will include the 
content of the element's model on top of the Model Master. You should consider 
whether anything on an element's model is better suited for inclusion on the Model 
Master. Also decide if hierarchical Model Masters might be suitable. See Hierarchical 
Model Masters on page 131 for details. 

• As you develop a Model Master, you should iteratively test it with suitable elements. 

7. Click Save. 

You can now: 

• Preview the effect that applying a Model Master will have. See Previewing Model 
Masters on page 130 for details. 

• Apply the Model Master to models. See Applying and removing Model Masters on 
page 130 for details. 

• For Active Enterprise: 

o Assign the Model Master to items such as matrices and Info panels so that any 
elements accessed from them in Active Enterprise use that Model Master 

o Use the Model Master as part of a condition so that elements without models get 
a model based on that Model Master when they are accessed in Active 
Enterprise. See Model Masters with Active Enterprise on page 132 for details on 
both of these. 

You can return and modify the Model Master at any time. Changes to the Model Master 
will update the models that use it. 

Previewing Model Masters 
Before you apply a Model Master, you can preview it. To do this, drag an element from the 
Explorer Tree and drop it onto a Model Master in a floating Model Masters pane. This gives you 
a Preview window. You can resize this window for a clearer view of the Model Master. This 
saves you from opening the actual Model Master. 

Applying and removing Model Masters 
You can apply Model Masters to models in several ways: 

• Use the Explorer Tree to open a Model Masters pane, and then drag a Model Master 
onto a model displayed in the workspace. By default, Business Architect tells you that 
the Model Master will be applied when dropped, as shown here: 
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• With the model displayed in the workspace, on the ribbon, click the Model tab, and 
then, in the Model Master group, use the gallery to select and apply a Model Master. 

 

• In the Explorer Tree, right-click the element, and then click Tools, and then click Apply 
Model Master. This displays the Apply Model Master dialog box. 

In each case, applying the Model Master saves the model, including any changes made prior to 
applying the Model Master. 

You can also associate a Model Master with an element type in Manage Themes. This means 
the Model Master is automatically applied to any models created for elements of that type. See 
Creating Element Types (page 152) and its Associating a Model Master with an element type 
sub section for details. 

To stop a model using a Model Master, with the model displayed in the workspace, on the 
ribbon, on the Model tab, in the Model Master group, click Use Blank. This removes any 
applied Model Master. 

Hierarchical Model Masters 
Hierarchical Model Masters let you build up layers of Model Master content. Each Model Master 
layer can include pinned content. Use Tree view to see hierarchical Model Masters. 
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The  symbol indicates a hierarchical Model Master. Click this to expand that particular 
hierarchy (as shown in the previous image, you also have Expand All and Collapse All 
commands). For example: 

 

To create Model Master hierarchies, do either of the following within Tree view: 

• Click New to create a Model Master and then move it into position (drag and drop just 
like an element). 

• Right click a Model Master and then click New. This creates a new Model Master that 
inherits from the original Model Master. 

Using Model Masters with Active Enterprise 
Active Enterprise has special features for Model Masters 

• The Element Navigates To setting for matrices and other panels. This controls the 
Model Master used when an element is accessed from the panel. 

• Conditional Model Masters. Rules that determine the Model Master used when an 
element does not have a model. 
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Element Navigates To takes precedence over any conditional Model Master setting. Both of 
these features are introduced below. 

The Elements Navigates To setting 

When developing a web based solution, you can control the Model Master used by an element 
when it is accessed from a matrix, Info panel, relationship, or certain graph panels. When one 
of these is selected on a model, the ribbon includes a Web tab. This includes the Element 
Navigates To command group. Use this to specify the Model Master used when an element is 
accessed from that item in an Active Enterprise environment. 

 

Tip 

If you have set a Model Master for an item and then decide against using a Model Master, 
click Own Page. This displays the element on its own model. You cannot use the gallery to 
unset a Model Master. 

 

Conditional Model Masters 

Active Enterprise lets you set conditions that, when met, result in a particular Model Master 
being used when an element does not have a model (this is a key point). This means that the 
element gets a model based on the Model Master. Conditional Model Masters can also be used 
with relationships (relationships don't have models). 

Conditions are rules that let you control both presentation and workflow when a repository is 
viewed in a web based solution. For example, you can impose a Model Master based on the 
status of an element, and the user involved. So, the Model Master for a finance user could 
include the full financial impact of an issue. Engineering users could be spared this detail and 
only see technical detail. Senior management could see everything. Conditional Model Masters 
let you tailor the presentation of elements to your various operational requirements and 
circumstances. Conditions can be simple or complex, and you can have multiple conditions 
working in conjunction. 

To access this functionality from Business Architect, in the File tab, under Manage Repository, 
click Conditional Model Master Settings. 



MooD 16 Getting Started Guide 
 

 134 

 
 

 

Click Conditional Model Masters to display the Active Enterprise Conditional Model 
Masters dialog box. 
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Use this dialog box to create your conditions. 
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Measures 

Note: See Measures in the Key concepts section (page 17) for general material on 
measures and their configuration in Manage Themes. The text below assumes 
you have measures available in the Explorer Tree. 

Measures record performance. For example, cost is a typical measure that you might want to 
record, and then display in Info panels, matrices and charts. Measures are also used to monitor 
and report on the status of elements. For example, if a project cost measure exceeds a given 
threshold, a traffic light indicator can change to red.  

Measures are elements, and therefore belong to a theme. Measures are also reusable items. 
Because of this, in the Explorer Tree, measures are listed in two places: 

• Under Themes, in whatever theme your measure types have been created in. For 
example, Measures in the image here: 

 

• In the Performance tab (in the Explorer Tree, click Libraries, and then click 
Performance). For example: 

 

Both are different views of the same measures. The Performance tab gives you more direct 
control over measures, while having the measures listed under Themes lets you see and use 
measures more easily when other tabs are displayed in the workspace (for example, when you 
want to drag a measure onto an element). 

Measures are applied to elements. Themes define what measures can be applied to their 
elements. As shown in the following image, if an element can have a measure, its definition will 
include a Measures field. This lists the measures applied to the element. 
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When a measure is applied to an element, this creates a measure instance. This is the value 
of that measure on that element for each epoch in effect. For example, the following image 
shows Cost from the previous image (you would right-click Cost, and then click Open to get 
this): 

 

All measure instances have the same naming format of Element.Measure.Epoch. This 
uniquely identifies them, as illustrated by Athena.Cost.Jun2011 in the preceding image. 

Note: Measures are often populated with data imported using a regular synchronization 
(SAT). For example, you might import project costs on a monthly basis. 

Throughout Business Architect, you can access and use measures and measure instances. For 
example, you can include them in an Info panel, as shown in the following image. 
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You can also use Epochs to record measures over a block of time. This allows calculations 
over time, and trend analysis. There is an Epochs guide. This is available within the Support 
area at www.moodinternational.com. 

  

http://www.moodinternational.com/
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Variants 
Variants are copies of elements. This can be a single element, or an element and its 
descendant elements. Variants know what element they are derived from, and elements know 
which variants have been created from them. Variants have the same definition, models and 
other information as the element they are copied from. However, once created, they are 
separate and independent elements. Originals and variants do not inherit or propagate changes 
between each other, and deleting one does not affect the other (other than removing the 
knowledge of being a variant, or of having a variant). 

Variants are useful if: 

• You have a core process that varies slightly between implementations. You can model 
the core process, and then quickly create the divergent cases you require. For example, 
a project process might vary slightly between geographic regions. You could have a 
core process for your primary region, and then create variants of this process for your 
remaining regions that you modify as required. 

• You want to progressively develop parts of a repository. You can create a prototype of 
some repository structure, and then create a variant in order to preserve a base point 
before you make further changes. You can then easily return to this base point and 
make comparisons. 

Finding out if an element is or has variants 

Task 14 To see if an element is or has variants: 

1. In the Explorer Tree, right-click the element, and then click Open. 

This displays the element's definition in the workspace. 

2. Click the Variants button (in the top right corner of the element's definition). 

 

This displays whether the element is a variant of another element, and whether it has 
variants of itself. 
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Tips 

• Each element's Examine pane includes information on its variants, for example: 

 

• You can filter the Explorer Tree by variants. This quickly shows you what variants you 
have in your element hierarchy. 

• If an element's shortcut menu includes Disconnect Variant, it's a variant. 

• Creating a variant and then immediately disconnecting it is an effective means of 
creating a copy of an element (there is no element copy command in Business 
Architect, although you can copy their symbols on a model). 

Creating variants 

Task 15 To create variants of an element: 

1. In the Explorer Tree, right-click the element and hold the mouse button down. 

(Creating variants is a right-click drag drop operation.) 

2. Position the pointer at the location you want to create the variant(s). 

 

The underlined element will become the variant's parent in the hierarchy (in this 
example Jupiter). 

3. Release the right mouse button. 

This displays the shortcut menu shown here: 
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4. Click Create Variant Here. 

This displays the Variant Wizard. 

 

About Connect as Variant 

The Connect as Variant command (which you can see in the image of the menu) 
makes an element a variant of a compatible element. This only links the two in that 
relationship. The actual element definitions are unaffected (that is, the variant is not 
overwritten with the definition of the element it is connected to). 

 

5. Use the wizard to complete the process. 

To help you: 

• You can choose to include all descendant elements, or just the element that you 
initially right-clicked. 
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• You can add a suffix or prefix to the names of the variants being created and apply 
this to just the initial element, or to all descendant elements. For example, you could 
add V1 as a suffix to the first variant, but leave the descendant variant elements with 
the same names as the originals. 

 

When the wizard is finished, the variants are added to the hierarchy at the requested 
location (in this example, under Jupiter). 
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SAT (the Synchronize library) 
Synchronization Activation Technology (SAT) lets you synchronize your repository with a 
variety of data sources. SAT is one of the most powerful features in MooD. It gets data into and 
out of your repository. For example, you might have a spreadsheet of costs that you need to 
import into your repository on a weekly basis, or you might want to populate a theme with 
details from a database. SAT lets you configure and manage such exchanges of information. 
Synchronizations can be scheduled, and they are fully audited. However, instead of importing & 
potentially duplicating data, consider using Data Table Themes instead. 

Business Architect comes with numerous preconfigured synchronizers including Microsoft 
Excel import and export, Microsoft PowerPoint, assorted databases, SSIS, XML, other MooD 
repositories and MooD Model Driven Documents (the Documents synchronizer). 

Some synchronizers exist to help you with repository maintenance, for example the Manage 
Aggregation Cache and Delete Audit History synchronizers. 

Synchronizers are managed on their own tab in Business Architect's workspace. To display 
this, in the Explorer Tree, under Libraries, click Synchronize. 

Everything you need to create, manage, execute and monitor SAT is on the Synchronize tab. 
The Insert gallery includes all the synchronizer types you have access to. Synchronizers can 
be organized into groups. The All and General groups are created for you, and, on the ribbon, 
click New (in the Groups command group) to add more. Individual groups of synchronizers can 
be executed directly, or according to a schedule. Hence, consider how your synchronizers will 
be executed when you organize them in your library. 

Typical synchronizers rely on mapping data from a source to a target in the repository. 
Business Architect guides you through the process. For example, the following image shows 
you the first step in adding a Microsoft Excel Import synchronizer. This is selecting an Excel file 
that includes the data (or an example of the data) you want to import. 

 

This next image (from later in the same process) shows how data from a source Excel 
spreadsheet is mapped to a particular element in a theme. Business Architect presents you 
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with the source and the target. You then link them, as shown, to produce a mapping. Elements 
that conform to this mapping will be created (or updated) when the synchronizer is executed. 

 

Individual mappings can include field modifiers. These transform the format or structure of 
data as it is imported. Numerous field modifiers are available. For example, the Hyperlink string 
modifier lets you import active web addresses into formatted text fields. There are also 
modifiers to convert the format of dates, split or combine strings, and round numbers. 

This is a very brief introduction to what synchronizers are, and where they are in Business 
Architect. The best way to learn about SAT is to experiment with importing source files. 
Provided you start with a valid source file, importing content using a synchronizer is just a 
matter of mapping it onto suitable targets in the repository. Business Architect will guide you in 
this. Export synchronizers are simpler in that you get the output you ask for in the 
synchronizer's target file format. 

Guides covering the Microsoft Excel Import synchronizer and an introductory video are 
available in the Support Area at www.moodinternational.com. There is also a video and guide 
covering Model Driven Documents (MDD) – this is the Documents synchronizer that you use to 
generate reports based on your repository content. 

  

http://www.moodinternational.com/
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Knowledge Activation 

Note: Knowledge Activation has been part of MooD for many versions. Whilst it remains 
a useful technology we now recommend using hyperlinks to link to external 
resources, particularly if you are using Active Enterprise. See Using hyperlinks 
instead of Knowledge Activation (page 145) for details. 

Knowledge Activation is the general term for getting a Process or Object element to open an 
external resource such as Microsoft Office documents, webpages, PDFs, files, sound clips and 
many more. Elements become linked to the piece of knowledge they activate. For example, if 
you have an element that represents a policy document, then that element appearing on a 
published model would open the actual policy document. Knowledge Activation makes the 
resources represented in a repository directly accessible. 

Knowledge Activation is only supported by the Process and Object default themes. You cannot 
use it with universal themes. And, if you want to use it with Active Enterprise, you must use the 
URL to the resource (C:\ paths will not work). 

Business Architect comes with a suite of Knowledge Activators. In the Explorer Tree, they are 
listed under Libraries. Each Activator is preconfigured to collect the detail required for that type 
of external data source. Activators are associated with elements. When you right-click an 
element in the Explorer Tree, its context menu includes an Activate command, and a 
Knowledge Activation submenu also with an Activate command. Use this to select and 
configure an Activator. 

 

Knowledge Centres 

In the Explorer Tree, under Libraries, Knowledge Activation also includes Knowledge 
Centres. Note that Knowledge Centres do not work with Active Enterprise. 

 

Knowledge Centres pull together collections of resources and make them readily available to 
a repository. For example, it can specify a location where all your external policy documents 
reside. Knowledge Centres help overcome potential issues when resources are moved, as 
they include logical, not physical, references. A wizard guides you through the process of 
creating Knowledge Centres. 

Using hyperlinks instead of Knowledge Activation 
Consider using hyperlinks in formatted text fields to link to external resources. These fields 
contain text that you format as hyperlinks using the Hyperlink command on the ribbon. 
Alternatively, select the text, right click and choose Insert Hyperlink. 
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SAT includes the Hyperlink field modifier that lets you import hyperlinks. A key benefit of this is 
that you can make imported hyperlinks open their target in a new window. A video covering this 
is available in the Support Area at www.moodinternational.com. 

You can also place hyperlinks directly on models. On the ribbon's Home tab, in the Insert 
group, if you click More, you will see Hyperlink. 

Here is an example of what you could do with hyperlinks. A Project element has a formatted 
text field that links to a resource. You are deploying an Active Enterprise solution and want to 
include a table complete with links that open these resources. Assume the solution is in an 
Active Enterprise folder inetpub\wwwroot\ProjectSolution and that the resources are in a sub 
folder called Resources. You would: 

• Use a Microsoft Excel Import synchronizer with the Hyperlink field modifier to populate 
the formatted text fields in the Project elements. Alternatively, manually populate the 
fields ensuring that they are formatted as hyperlinks. 

Assuming the server is called SolServer.CloudApp.Net, the hyperlinks would have this 
format: 

http://SolServer.CloudApp.Net/ProjectSolution/Resources/ProjectResource 

• Create a Data Sheet matrix that finds the Project elements and includes the formatted 
text field as a column. Also make sure the Matrix tab has: 

o Publish matrix set to Yes (as HTML). This setting is in the Matrix group. 

o Plain text HTML set to False. This setting is in the Cells group. 

• Include the matrix on the model. 

 

  

http://www.moodinternational.com/
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Active Enterprise 
Active Enterprise is the module that web enables models. Active Enterprise is integrated into 
Business Architect. Action panels are controls that allow you to configure the pages in your web 
solution (pages are models). In addition, many of the other items that you place on models 
include web configuration options, for example, animation effects in the Radial chart. 

The ribbon for every model includes a Web tab. For example: 

 

Use these to control how a model appears and functions in a browser. For example, the Allow 
Navigation setting determines whether elements open their own models when the user clicks 
them. As far as possible, the Preview command lets you test your models without setting up an 
actual Active Enterprise installation. 

Active Enterprise components 

Publishing solutions in a live environment involves two other pieces of MooD technology: 

• Business Integration Engine (always referred to as BIE) 

BIE optimizes your repository for Active Enterprise and maintains an active 
connection to the database. 

• Active Publisher 

This is the tool that produces and maintains the compiled ASP.NET web portal to 
your repository. 

Note: Both Internet Information Server (IIS) and ASP.NET need to be on the 
same machine as Active Publisher. 

Documentation is available covering Active Enterprise setup. 

Although a standard Business Architect licence lets you develop web solutions (i.e. use and 
test Action panels), to deploy these solutions you need an Active Enterprise licence.  

Home Pages 

Each user and user group in Business Architect has a Home Page. This is the model displayed 
when a user logs into a repository by means of Active Enterprise. This model can be the user's 
model, a specific element's model, or the model associated with the user group that the user is 
a member of. For example: 
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See Users, user groups and permissions in the Introducing administration section (page 149) 
for more details on user management in Business Architect. 
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Introducing administration 
If you are a member Business Architect's Administrators user group, you have access to 
administrative features in Business Architect. Some are introduced briefly here. 

Note: A lot of repository administration is performed in Repository Manager (such as 
upgrades and backups). See Repository Manager on page 11 for an introduction. 

Users, user groups and permissions 
Business Architect has users and user groups. By default, there is an Administrator user 
and an Anonymous user. The Administrator user is a member of the Administrators user 
group. All users are automatically members of the Everyone user group. Users get their 
permissions from the user group(s) that they are members of. Members of the Administrators 
user group can create additional users and user groups, and reset passwords. 

The Anonymous user exists to provide login free access to a repository. Hence, it is an 
entirely locked down user. You must specifically grant View on Web permission to those areas 
you want the Anonymous user to see. 

Elements have permissions set by user group. This means that elements can have different 
permissions for different user groups. For example, one user group might be allowed to edit an 
element, while another user group cannot even view that element. There are also library 
permissions for certain administrative powers, including managing matrices, queries and 
synchronizers. Again these are set by user group. 

Collectively, users, user groups and permissions let repository administrators implement a user 
and permissions hierarchy appropriate to the needs of their repository. Users and Groups are 
themes in their own right, and permissions are managed centrally by means of the 
Permissions tab. You can also have field permissions on themes. However, most of the time, 
administrators will deal with element and library permissions. 

There is a User Management and Permissions Guide that covers this in detail. 

Note: You can also set permissions by user, but we recommend that you create user 
groups, apply permissions by user group, and then give your users membership of 
an appropriate user group. 
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Audit and Security 
Members of the Administrators user group can control auditing and security using the Audit 
and Security dialog box. Click File, point to Manage Repository, and then click Audit and 
Security Settings. 

 

The preceding image shows the Audit Size tab. You can use this tab to occasionally clear 
down the audit history. This can get quite large, and affect performance. However, typically 
administrators will use the Delete Audit History synchronizer to automate the management of 
this. 

The Password Settings tab lets you enforce passwords, and ensure their complexity. 
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Introducing Manage Themes 
Manage Themes is where you define and maintain the meta-model for your repository. 
Designing and maintaining meta-models is advanced usage but it is helpful to understand what 
can be done in Manage Themes and how the definitions in your meta-model dictate what you 
can do in Business Architect. Much of this has been covered elsewhere in this guide 
(particularly in the Key Concepts section starting on page 14) so this section concentrates on 
the mechanics of using Manage Themes for some common tasks. 

Only members of the Administrators user group can undertake theme management. All 
themes are created and maintained within a single dialog box accessible from the ribbon. Click 
File, point to Manage Repository, and then click Manage Themes. This opens the Manage 
Themes dialog box, as shown in the following image: 

 

Manage Themes is organized in two sections: 

• Themes. This is where you create themes, element types and measure types. 

• Connections. This is where you create standard relationships and measure 
relationships. 

Hiding themes from Explorer Tree 
You might want to hide some of the default themes. To do this, change the Visible setting for 
each theme that you want to hide, as shown here. 
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Creating themes 
To create a new universal theme, open Manage Themes, click <New Theme> and give it a 
name. The same name will appear in the Explorer Tree. 

 

New themes are not useable until they contain at least one element type. 

Creating element Types 
In any universal theme, to add a new element type, click <new Type> and give it a name. 

 

Once the element type is named, you get three tabs: Names, Appearance and Definition. Use 
these to define the element type. 

The Definition tab is where you specify the fields that each element of that type will have. 
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Use: 

• Fields to add any standard fields you require. For example, date fields and number 
fields. The dialog box lets you add new field types. Field types are reusable. For 
example, once you define a Pick List field, you can use it anywhere. 

Note: Formatted text fields hold text in HTML format, and as such, it can 

include hyperlinks. Users cannot edit the raw HTML encoding. There is a 

button on the ribbon to format text selections within formatted text fields, and to 

convert portions of text into hyperlinks, and there is a Hyperlink field modifier 

to let you SAT hyperlinks into formatted text fields (for which there is a video in 

the Support Area at www.moodinternational.com). 

• Relationship to add a field that will hold a standard relationship to another element 
type. You define standard and measure relationships on the Connections tab. 

• Measure to add a field that will hold a measure relationship to a measure type. 

If you want to associate a Model Master with an element type, click Type Model and then use 
the Appearance tab to select the Model Master. For example: 
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Creating standard relationships 
See Relationship in the Key Concepts section (page 16) for some guidance on this. Also, a 
video demonstrating this is available within the Support Area at www.moodinternational.com. 

Creating measure types and measure relationships 
A Measures guide covering how to create measure types and relationships in Manage Themes 
is available within the Support Area at www.moodinternational.com. There is also a video. 

The diagram below is taken from the guide. It illustrates creating a measures theme, measure 
type, measure relationship and then applying a measure to an element. If you need more 
information, see the guide. 

http://www.moodinternational.com/
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